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About Complex Compression Hardware,
Systems Inc
Complex Compression Hardware, Systems Inc (CCH Systems) is a for-profit hardware and software
development company based in San Francisco, California that creates advanced video compression
technologies. CCH oversees an open source foundation that drives development of the software
harnessing the open source community. While CCH's main video compression software is open
source and freely downloadable, the stable build is very complex and not suitable for enterprise use.

When the open source version of the software reaches certain milestones, the code is forked and
CCH integrates enterprise-focused tools to make the software suitable for enterprise use. CCH also
sells several hardware devices designed specifically to offload video compression workloads for
enterprise customers. The CCH hardware devices can accelerate compression speeds better than
that of stock hardware.

When creating their enterprise products, CCH ensures that the software goes through a rigorous
quality assurance (QA) process so that every new enhancement to the compression algorithms is
fully optimized. Previously, the QA team had a small datacenter with 30 dedicated systems to
perform these QA checks. However, the IT team responsible for managing this datacenter found it
very difficult to maintain the systems, especially since all of the machines needed to be exact
duplicates for testing. The IT team also found that testing the software on dedicated hardware was
not actually required for the types of tests that the QA team needed to perform. Additionally, the
company's management team could not justify the cost of maintaining their relatively large
datacenter.
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Lab Scenario
CCH started decommissioning the QA team's datacenter two months ago, opting instead to
virtualize their testing workloads to save time and money. Through their local Citrix partner, CCH
purchased several XenServer 6.0 Platinum licenses and designed a plan to implement their new QA
Lab over the next week.

You are a XenServer 6.0 administrator in charge of implementing the new QA Lab by the specified
deadline. In addition to setting up XenServer, you also need to implement Citrix Provisioning
Services to create virtual machines that the QA team can use to perform their testing. A few
members of the IT team will help you with the initial hardware installation and networking set up,
but will move on to other projects once the initial set up is complete.

16 Module 2: Installing and Configuring XenServer © Copyright 2012 Citrix Systems, Inc.



Lab Environment
The following table provides descriptions and roles of each virtual machine in the lab environment:

Virtual Machine Role OS Hostname

DomainController Windows Server 2008 DC• Domain Controller
R2

• SQL Server

Router Performs routing from Linux Router
the Quality Assurance
lab network to the IT
network. The IT
network provides
access to the internet
and several key
company services.
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User Credentials
Please use the following credentials as you complete these exercises:

CCH\CitrixAdmin

• Username: CCH\CitrixAdmin
• Password: Password1
• Member of: CCH\Domain Admins

Win7Admin

• Username: Win7Admin
• Password: Password1
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Exercise 2-1: Installing XenCenter

Scenario

The datacenter staff has already installed Citrix XenServer 6.0 onto a server for you. A member of
the IT networking team set up the preliminary networking of the device so that you can access the
management interface. The datacenter staff has provided to you a detailed file containing server and
peripheral information which has been downloaded to your desktop. The company's Active
Directory administrator also set up a virtual machine to act as your department's domain controller.

In order to begin administrating your XenServer host, you need to install Citrix XenCenter to your
desktop and connect to your XenServer host.

Estimated time to complete this exercise: 5 minutes

Installing XenCenter
1. Launch the XenCenter setup wizard located in C:\xenserver\client_install folder.

a. Go to Start > Computer.
b. Browse to C:\XenServer\client_install.
c. Double-click XenServer-6.0.0-XenCenter.msi.

2. Install XenCenter in the default directory using the XenCenter wizard.
a. Click Next in the Citrix XenCenter Setup wizard.
b. Click Next to accept the default installation directory C:\Program Files

(x86)\Citrix\XenCenter\.
c. Click Install to begin installing XenCenter.

The Installation Complete screen appears.
d. Click Finish.

Launching XenCenter and Adding a XenServer Host
1. Launch XenCenter and begin adding a new server.

a. Go to Start > Citrix XenCenter.
b. Click No to specify not to check for XenServer updates.
c. Click Add New Server from the XenCenter toolbar.

2. Add the XenServer listed to the XenCenter console using the XenServer IP addressfrom the
student reference file. Use the root/Password1 credentials to log on and save the connection
state on startup.
a. Type the XenServer IP address listed in the Student Reference file in the server field.
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b. Type root in the User name field and Password1 in the Password field.
c. Click Add.
d. Select Save and restore server connection state on startup and click OK.
e. Click Close in the License Manager window.
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Exercise 2-2: Licensing the XenServer Host

Scenario

You recently received the XenServer Platinum license from Citrix Systems, Inc and need to license
the XenServer host. You decide to use the Citrix License Server Virtual Appliance to act as this
license server.

You need to import and configure the license server virtual appliance, install the license, and then
license the XenServer host to that server.

Estimated time to complete this exercise: 15 minutes

Importing the Citrix License Server Virtual Appliance
1. Begin importing the "Citrix License Server Virtual Appliance.xva" file located in

c:\XenServer\ on to the XenCenter.
a. Click File > Import.
b. Click Browse and browse to c:\XenServer\.
c. Select the Citrix License Server Virtual Appliance.xva file and click Open.
d. Click Next.

2. Specify your local XenServer as the home server and use its local storage for the new virtual
machine. Use the default Network 0 virtual network interface and complete the wizard using
the default options specifying to start the virtual machine after the import is completed.
a. Select XenServer as the home server and click Next.
b. Select Local storage as the storage for the new virtual machine and click Import.
c. Ensure that Network 0 is listed as the only virtual network interface and click Next.
d. Verify Start VM(s) after import is selected and click Finish.

A virtual machine appears in the resource pane.
3. Rename the "2. Citrix License Server Virtual Appliance" virtual machine to "LicenseServerVPX."

a. Right-click the 2. Citrix License Server Virtual Appliance virtual machine and click
Properties.

b. Type LicenseServerVPX in the Name field and click OK.

Configuring the Citrix License Server Virtual Appliance
1. Access the console of the LicenseServerVPX virtual machine to begin configuring the virtual

appliance. Set the root password to Password1.
a. Click the Console tab.
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b. Click in the console and press Enter.
c. Type Password1 and press Enter to set the root password.

Ignore the message that the password is bad. Passwords are not displayed as you type
them.

This entry is case sensitive, so it must be exact.
d. Type Password1 again to confirm the password and press Enter.

2. Configure the server name as "license-server" and domain suffix as "cch.local". Specify not to
use DHCP to configure the network settings.
a. Type license-server as the host name and press Enter.

This entry is case sensitive, so it must be exact.
b. Type CCH.local for the domain suffix and press Enter.
c. Type n and press Enter to ensure DHCP is not used for the network settings.

3. Configure the IP, subnet address, and gateway using the information below and allow the
virtual appliance to restart. Set the admin password to Password1.
• IP Address: 10.10.<X>.50

Where <X> is the XenServer ID.

• Netmask: 255.255.255.0
• Gateway: 10.10.<X>.1

Where <X> is the XenServer ID.

a. Use the above information to configure the networking settings.
b. Review the network settings. Type y and press Enter if the settings are correct.

The virtual appliance finishes its set up.
c. Type Password1 in Specify an admin password and confirm prompts and press Enter.

Importing Licenses into the Citrix License Server Virtual
Appliance
1. Use Internet Explorer on the lab desktop to access the administration section of the Citrix

License Server located athttp://10.10.<X>.50:8082, replacing <X> with the server ID in your
student reference guide.
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a. Launch Internet Explorer on the lab desktop and browse to
http://10.10.<X>.50:8082 to access the Citrix License Administration Console.
Replace <X> with the server ID in the student reference guide.

b. Click Administration in the upper-right hand portion of the screen.
c. Log on with the admin/Password1 credentials.

2. Import the XenServer license located in C:\XenServer\xenserver_license to the
Citrix License Server Virtual Appliance. Do not close Internet Explorer.
a. Click Vendor Daemon Configuration and click Import License.
b. Click Browse and browse to C:\XenServer\xenserver_license.
c. Select xenserver_platinum.lic and click Open.
d. Click Import License and click OK.

Do not close Internet Explorer.

3. Use XenCenter to restart the Citrix License Server.
a. In XenCenter, right-click the LicenseServerVPX virtual machine and select Reboot.
b. Click Yes.

The License Server virtual machine restarts. Please allow it to restart before continuing.
4. Use Internet Explorer to access the license server console and verify that the license was

installed correctly. Close Internet Explorer.
a. In Internet Explorer, click Dashboard in the Citrix License Administration Console.
b. Verify that a license exists for Citrix Provisioning Services, Citrix StorageLink Platinum,

and Citrix XenServer Platinum.
c. Close Internet Explorer.

Assigning Licenses to XenServer Hosts
1. Use the License Manager in XenCenter to begin applying a license to the XenServer.

a. Select Tools > License Manager from the XenCenter menu.
b. Select yourXenServer and click Assign License.

2. Apply a Citrix XenServer Platinum Edition from the license server located at 10.10.<X>.50
using the default port, replacing <X> with the server ID in your student reference guide.
a. Select Citrix XenServer Platinum Edition.
b. Type 10.10.<X>.50 in the Name field and leave the default port as 27000.

Replace <X> with the server ID in the student reference guide.
c. Click OK to assign the license.
d. Click Close to close the License Manager.
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Exercise 3-1: Managing Networks

Scenario

A request was submitted to the CCH networking team to allow for network and internet access to
the virtual machines on the XenServer host. Since you will be hosting your own DHCP and Active
Directory servers in your environment, the networking team had to use a vLAN to insure there
would be no interference with normal networking operations. The networking team configured a
routing virtual machine on the company network to allow for network access to company assets.

To complete the networking implementation you need to configure a network on the assigned
vLAN. Then you need to add the new vLAN Network to the Router virtual machine to perform the
routing between the different networks. You also need to add the new network to the
DomainController virtual machine to provide Active Directory, DHCP, and DNS services for your
network.

Before You Begin

To begin this lab, ensure that the following virtual machines are running:

• LicenseServerVPX

Estimated time to complete this exercise: 10 minutes

Creating a New Network
1. Use the New Network wizard in XenCenter to create a new External Network called vLAN

Network.
a. Click XenServer node and click the Networking tab.
b. Click Add Network.
c. Select External Network and click Next.
d. Type vLAN Network in the Name field and click Next.

2. Configure the new network to use the VLAN ID listed in the student references file using the
NIC "NIC 2". Set the network to be added automatically to new virtual machines.
a. Select NIC 2 from the NIC drop-down menu.
b. Type the Network vLAN ID found in the Student_Reference.txt file into the vLAN field.
c. Select Automatically add this network to new virtual machines and click Finish.
The vLAN Network network entry is displayed.
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Adding the Virtual Network Interface to Virtual Machines
1. Add the vLAN Network interface as the second interface of the Router virtual machine using

an auto-generated MAC address and start the Router virtual machine.
a. Select the Router virtual machine and click the Networking tab.
b. Click Add Interface.
c. Select vLAN Network from the Network drop-down menu and click Add.
d. Click Start in the toolbar to start the Router virtual machine.

2. Add the vLAN Network interface as the first interface of the DomainController virtual machine
using an auto-generated MAC address and start the DomainController virtual machine.
a. Select the DomainController virtual machine and click the Networking tab.
b. Click Add Interface.
c. Select vLAN Network from the Network drop-down menu and click Add.
d. Click Start in the toolbar to start the DomainController virtual machine.
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Exercise 4-1: Adding an ISO Library Storage
Repository

Scenario

Another administrator created a Windows file share on a back end storage device to use as a
central distribution point of DVD media in ISO format for the whole team. He also populated it
with many commonly used ISO files.

You want to use this Windows file share as the XenServer's source of ISO files for use with virtual
machines. To do this, you need to create a new ISO Library storage repository on your XenServer
host.

Before You Begin

To begin this lab, ensure that the following virtual machines are started:

• DomainController
• LicenseServerVPX
• Router

Estimated time to complete this exercise: 5 minutes

Creating a Network ISO Library
1. In XenCenter, begin creating a new Windows File Sharing (CIFS) ISO library storage

repository named "ISO-Library".
a. In XenCenter, select yourXenServer, then click New Storage in XenCenter.
b. Select Windows File Sharing (CIFS) under ISO Library and click Next.
c. Type ISO-Library in the name field and click Next.

2. Configure the ISO-Library to use the ISO Library Share path in the student reference file using
the root/Password1 credentials.
a. Use ISO Library Share Path from the student reference file as Share Name.
b. Select Use different user name.
c. Type root in the User name field and Password1 in the Password field.
d. Click Finish.

A new storage repository called ISO-Library appears under your XenServer host.
3. Verify that the contents of the c:\xenserver\ISO folder appear in the ISO-Library.

a. Select ISO-Library.
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b. Click the Storage tab.
The Storage panel displays a list of ISO images that are on the file share, including
WINDOWS_2008_R2_64Bit_SP1.ISO and PVS_6.0.iso.
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Exercise 4-2: Attaching a Virtual Disk
Storage Repository

Scenario

By request, IT set up storage space on a back end storage appliance to use with the XenServer host.
The storage is being shared through the NFS protocol. You decide to use this network share as
virtual machine storage of more mission critical virtual machines.

You need to attach this NFS share to the XenServer host as a virtual disk storage repository.

Before You Begin

To begin this lab, ensure that the following virtual machines are started:

• DomainController
• LicenseServerVPX
• Router

Estimated time to complete this exercise: 10 minutes

Adding Virtual Disk Storage to a XenServer Host
1. Create a new NFS storage repository named "Shared VM Storage" using the information

located in the student reference file on the landing desktop.
a. Click New Storage.
b. Select NFS VHD and click Next.
c. Type Shared VM Storage in the Name field and click Next.

2. Use the NFS VM Storage Share name in the student reference file to scan for an existing
storage repository.
a. Type the <NFS VM Storage Share Name> from the student reference guide in the

Share Name field.
b. Click Scan.

3. Reattach the existing storage repository to the XenServer and set it as the default storage.
a. Select Reattach an existing SR, select the storage repository listed, and click Finish.
b. Click Yes to reattach the Shared VM Storage.
c. Right-click Shared VM Storage and click Set as Default.
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For future virtual machines, the Shared VM Storage will be the default storage repository.
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Exercise 4-3: Creating A New Virtual
Machine With an Existing Virtual Disk

Scenario

Another administrator created a few virtual machines that you may need. To reduce duplication of
effort she copied the virtual disk from her assigned NFS storage space to the one created for use
with this XenServer host. One of the virtual disks contains Windows 7 in a sysprepped state that
you eventually want to use as a Windows 7 template.

You need to create a new Windows 7 diskless virtual machine and attach this virtual disk to it.

Before You Begin

To begin this lab, ensure that the following virtual machines are started:

• DomainController
• LicenseServerVPX
• Router

Estimated time to complete this exercise: 10 minutes

Creating a Diskless Virtual Machine
1. Launch the New VM wizard on your XenServer Host.

a. Select XenServer.
b. Click New VM on the toolbar.

The New VM wizard launches.
2. Use the Windows 7 (32-bit) template to create a virtual machine named Windows7-Template .

a. Select the Windows 7 (32-bit) template from the Select a VM template screen and click
Next.

b. Type Windows7-Template in the Name field and click Next.
3. Specify for the virtual machine to boot from the network and use the default home server.

a. Select Boot from network and click Next.

Though this virtual machine will not be starting from the network, this option must be
specified to create a diskless virtual machine.

b. Click Next to accept the default home server.
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4. Use the default number of vCPUs but change the memory to 1024MB. Specify to create a
diskless VM.
a. Verify that the default Number of vCPUs is set to 1.
b. Type 1024 in the Memory field and click Next.
c. Select Create a diskless VM that boots from the network and click Next.

5. Ensure vLAN Network is the only virtual network interface that will be added and finish the
New VM wizard specifying for it to start automatically.
a. Verify that vLAN Network is selected and click Next.
b. Verify that Start the new VM automatically is selected and that all virtual machine

properties are correct.
c. Click Finish.

Adding an Existing Virtual Hard Disk from Shared Storage
1. View the Windows7-Template virtual machine's console and note that it attempted to start

unsuccessfully from the network.
a. Click the Windows7-Template virtual machine and click the Console tab.
b. View the boot device errors listed in the console. If the console does not appear, click Start

on the XenCenter toolbar.

The virtual machine followed its boot up order by attempting to start on the network,
then the DVD-drive, followed by a Hard Drive. Because none of these boot methods exist,
the virtual machine was unable to find a bootable device and turned off.

2. View the Windows7-Template 's boot order.
a. Right-click Windows7-Template and click Properties.
b. Click Boot Options in the Properties dialog box.

3. Set the boot order to first boot from DVD-Drive and then from Hard Disk. Disable booting
from the Network.
a. Select Network and click Move Down two times to set it last in the Boot order.
b. Ensure the checkbox for Network is deselected.
c. Ensure that the DVD-Drive and Hard Disk checkboxes are selected and click OK.

4. Attach the "(No Name) 24 GB" disk from the Shared VM Storage to the Windows7-Template
virtual machine.
a. Click the Storage tab and click Attach.
b. Select the (No Name) 24 GB disk from the Shared VM Storage node.
c. Click Attach.
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Do NOT start up the Windows7-Template virtual machine at this time.
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Creating and Managing
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Exercise 5-1: Creating Virtual Machines

Scenario

You know that you will need virtual machines running Windows 7, Windows Server 2008 R2, and
Linux in the future to perform your duties. Instead of creating each new virtual machine from
scratch, you want to create base install templates of each operating system for you and other
administrators to use on demand.

Since another administrator already created a Windows 7 template for you, you need to create a
Windows Server 2008 R2 and Linux virtual machine to convert into a template at a later time.

Before You Begin

Before you begin this lab, ensure that the following virtual machines are started:

• DomainController
• Router
• LicenseServerVPX

Estimated time to complete this exercise: 15 minutes

Creating a Windows Virtual Machine
1. Launch the New VM wizard on your XenServer Host.

a. Select XenServer.
b. Click New VM on the toolbar.

The New VM wizard launches.
2. Use the Windows Server 2008 R2 (64-bit) template and call it WindowsServer2008R2-

Template .
a. Select Windows Server 2008 R2 (64-bit) and click Next.

The Name screen appears, asking for a machine name and description.
b. Type WindowsServer2008R2-Template in the Name field and click Next.

3. Specify to start from the WINDOWS_2008_R2_64Bit_SP1.iso and do not assign a home server.
a. Select WINDOWS_2008_R2_64Bit_SP1.ISO from the Install from ISO library or DVD

drive drop-down list and click Next.
b. Select Don't assign this VM a home server and click Next.

4. Accept the default Number of vCPUs (1) and change Memory to 1536 MB. Accept the default
shared storage location and size (24 GB) of the virtual disk.
a. Verify that 1 is listed in the vCPU field.
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b. Type 1536 in the Memory field and click Next.
c. Verify that Shared VM Storage is selected and the size is 24 GB.
d. Click Next.

5. Ensure vLAN Network is the only virtual network interface that will be added and finish the
New VM wizard specifying for it to start automatically.
a. Verify that vLAN Network is selected and click Next.
b. Verify that Start the new VM automatically is selected and that all virtual machine

properties are correct.
c. Click Finish.

Installing Windows Server 2008 R2
1. View the console of the WindowsServer2008R2-Template virtual machine and ensure that the

virtual machine booted from the Windows installation ISO.
a. Select the WindowsServer2008R2-Template virtual machine and click the Console tab.
b. Verify that the virtual machine booted from the Windows installation ISO.

2. Begin the Windows Server 2008 R2 Enterprise full installation using the language defaults.
a. Accept the default language settings and click Next.
b. Click Install now.
c. Select the Windows Server 2008 R2 Enterprise (Full Installation) operating system and

click Next.
d. Respond to the license agreement and click Next.

3. Use the custom installation to format all of the unallocated space of Disk 0 and then begin the
install.
a. Click Custom (advanced) for the installation type.
b. Select Disk 0 Unallocated Space as the installation location and click Next.
Windows will begin the operating system installation.

Please continue to the following exercises as Windows installs.

Creating a Linux Virtual Machine
1. Launch the New VM wizard on your XenServer Host.

a. Select XenServer.
b. Click New VM on the toolbar.

The New VM wizard launches.
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2. Create a virtual machine named CentOSLinuxServer-Template , using the CentOS 5.0 (32-bit)
template.
a. Select CentOS 5 (32-bit) and click Next.

The Name screen appears.
b. Type CentOSLinuxServer-Template in the Name field and click Next.

The Installation Media screen appears.
3. Specify http://vault.centos.org/centos/ as the installation source for the new

virtual machine. Do not assign a host server.
a. Select Install from URL.
b. Type http://vault.centos.org/centos/ in the Install from URL field and click

Next.
c. Select Don't assign this VM to a home server and click Next.

4. Specify to use a single vCPU, 512 MB of memory, and to store the virtual disk on the Shared
VM Storage.
a. Accept the default Number of VCPUs (1), type 512 into the Memory field, and click

Next.
b. Accept the default virtual disk setup and click Next.

5. Ensure vLAN Network is the only virtual network interface that will be added and finish the
New VM wizard specifying for it to start automatically.
a. Verify that vLAN Network is selected and click Next.
b. Verify that Start the new VM automatically is selected and that all virtual machine

properties are correct.
c. Click Finish.

Installing CentOS Linux
1. Open the CentOS Linux virtual machine console and specify English as the default language.

a. Select CentOSLinuxServer-Template and click the Console tab.
b. Click into the Console window.

The Choose a Language screen appears.

Navigation in these screens uses the following keys:
• Tab / Alt-Tab or Up/Down/Left/Right Arrows: Move between elements
• Space: Select / Deselect
• F12: Accept the entered values and move to the next screen

c. Accept the default language English and select OK.
2. Configure IPv4 information to be dynamically assigned by the DHCP server and remove IPv6

support.
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a. Select Enable IPv4 support and select Dynamic IP configuration (DHCP).
b. Deselect Enable IPv6 support.
c. Select OK.
d. Select OK if prompted on the Welcome dialog box.

3. Continue the CentOS installation by accepting the defaults for the Partition Type and Partition
Layout.
a. Select Yes to create new partitions on the drive.
b. Arrow to Remove all partitions on selected drives and create default layout and then

select OK.
c. Select Yes.

The Review Partition Layout screen appears.
d. Select No.

4. Accept the default values for the networking. Manually set the hostname of the server to
CentOSLinuxServer.
a. Select OK.
b. Press the Down arrow then Space to select manually.
c. Press the Right arrow and type CentOSLinuxServer-Template.
d. Select OK.

The Time Zone Selection screen appears.
5. Specify the time zone for your location and set Password1 as the Root Password.

a. Select the nearest region or time zone for your location and select OK.
b. Type Password1 in the Password and Password (confirm) fields.
c. Select OK.

6. Accept the default desktop and complete the installation. Reboot the virtual machine when the
installation is completed.
a. Select OK to accept the default desktop.
b. Select OK to start the installation.

Installation of CentOS 5 on the virtual machine starts.
c. Select Reboot after the installation is complete.
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Exercise 5-2: Installing the XenServer Tools

Scenario

You recently installed CentOS and Windows Server 2008 R2 onto new virtual machines. Now you
need to install the XenServer Tools onto each virtual machine to make the Linux system
paravirtualized and Windows server system hardware virtualization assisted.

Installing the XenServer Tools at this point allows for subsequent installations of the tools to
complete much faster. But once the Windows Server 2008 R2 virtual machine is sysprepped and
turned into a template it will need to be installed again after every clone. This reinstallation is
required because the sysprep process removes required XenServer device drivers.

Before You Begin

Before you begin this lab, ensure that the following virtual machines are running:

• CentOSLinuxServer-Template
• Router
• DomainController
• LicenseServerVPX
• WindowsServer2008R2-Template

Estimated time to complete this exercise: 15 minutes

Installing XenServer Tools for Linux Virtual Machines
1. Attach the xs-tools.iso to the CentOSLinuxServer-Template virtual machine and then access it's

console. Log on using the root/Password1 credentials.
a. Select xs-tools.iso from the DVD Drive 1 drop-down menu in the CentOSLinuxServer-

Template virtual machine Console tab.
b. Click into the console log on using the root/Password1 credentials.

2. Use the linux command prompt to mount the ISO located at /dev/xvdd to the /mnt directory
mount point. Access the /mnt/Linux directory and view its contents.
a. Type mount /dev/xvdd /mnt and press Enter.

The block device is mounted as read-only.
b. Type cd /mnt/Linux and press Enter to access the /mnt/Linux directory.
c. Type ls and press Enter to view the directory contents.
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Note the different packages available to installing the tools using different package
managers.

3. Install the tools using the install.sh script and then reboot the virtual machine.
a. Type ./install.sh and pres Enter.
b. Type y when the prompt appears asking to continue.

Once the installation is completed the virtual machine must be restarted.
c. Type reboot and press Enter at the prompt to restart the virtual machine.

4. Use XenCenter to verify that the XenServer tools were installed correctly.
a. Wait for the virtual machine to complete the reboot before continuing.
b. Click CentOSLinuxServer-Template virtual machine.
c. Click the General tab.
d. Verify that the virtualization state is listed as Optimized (Version 6.0 Installed).

If the "Virtualization state" reads as "Optimized," the installation was successful.
5. Eject the xstools.iso file from the CentOSLinuxServer-Template .

a. Click the Console tab.
b. Click Eject next to the DVD drive drop-down to eject the ISO.

Installing XenServer Tools for Windows Server 2008 R2
1. Access the console of WindowsServer2008R2-Template virtual machine and set the

Administrator password to "Password1".
a. Click WindowsServer2008R2-Template and click Console.
b. Click OK to change the user's password.
c. Type Password1 into the Password and confirm password field and click OK.
d. Click OK.

2. Attach the xs-tools.iso to the WindowsServer2008R2-Template virtual machine and launch the
installer.
a. Select xs-tools.iso from the DVD Drive 1 drop-down menu.
b. Click Run xensetup.exe from the AutoPlay dialog box.

3. Respond to the license agreement and install the tools into their default location. Restart the
virtual machine when prompted.
a. Respond to the license agreement and click Next.
b. Accept the default installation destination and click Install.

Allow the XenServer Tools to install before continuing.
c. Verify that Reboot now is selected and click Finish.

46 Module 5: Creating and Managing Virtual Machines © Copyright 2012 Citrix Systems, Inc.



4. Eject the xen-tools.iso from the virtual machine. When the WindowsServer2008R2-Template
virtual machine reaches the logon screen, view its virtualization state.
a. Select <empty> from the DVD Drive 1 drop-down menu.
b. Wait for the WindowsServer2008R2-Template virtual machine to complete the restart.
c. Click WindowsServer2008R2-Template virtual machine and click the General tab.
d. Ensure that the virtualization state says "Optimized (version 6.0 installed)"

The Optimized virtualization state indicates that the XenServer Tools were installed
successfully.
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Exercise 5-3: Creating Templates

Scenario

You recently created a CentOS Linux, Windows Server 2008 R2, and Windows 7 virtual machine to
be used as templates. You now need to create the templates from these virtual machines.

The Windows Server 2008 R2 virtual machine first needs to be sysprepped to generalize it before it
can be made into the template. While a Windows 7 virtual machine usually requires this as well,
you received the virtual disk already in a syspreped state from the administrator that created it.
Linux based virtual machines do not require this step.

The Sysprep process generalizes a Windows virtual machine into an "out-of-the-box" state by
removing unique identifiers within the operating system. This is required to ensure that each newly
provisioned version of the template creates new identifiers to make it unique.

Before You Begin

To begin this lab, ensure that the following virtual machines are started:

• CentOSLinuxServer-Template
• Router
• DomainController
• LicenseServerVPX
• WindowsServer2008R2-Template

Estimated time to complete this exercise: 10 minutes

Performing a Sysprep on the WindowsServer2008R2-
Template
1. Log on to the WindowsServer2008R2-Template virtual machine as the Administrator user.

a. Click the WindowsServer2008R2-Template virtual machine in XenCenter and click the
Console tab.

b. Click Send Ctrl+Alt+Del and log on to the virtual machine using the
Administrator/Password1 credentials.

2. Launch the Sysprep utility from the C:\Windows\System32\sysprep folder.
a. Click Start > Computer and browse to C:\Windows\System32\sysprep.
b. Double-click the sysprep.exe file.
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3. Set the System Preparation tool to enter the System Out-of-Box-Experience and to generalize
the virtual machine. Set the tool to Shutdown the virtual machine when the sysprep is
completed and then perform the sysprep.
a. Select Enter System Out-of-Box Experience (OOBE) from the System Cleanup Action

drop-down menu.
b. Select the Generalize checkbox.
c. Select Shutdown from the Shutdown Options drop-down menu.
d. Click OK to perform the sysprep.

4. Please allow for the sysprep process to complete and the virtual machine to shut down before
continuing.

Converting the Virtual Machines into Templates
1. Convert the WindowsServer2008R2-Template virtual machine into a template.

a. Right-click the WindowsServer2008R2-Template virtual machine and click Convert to
Template.

b. Click Convert in the Convert VM to Template warning.
The WindowsServer2008R2-Template moves to the bottom of the list and acquires a blue icon
indicating that the virtual machine is now a template.

2. Convert the Windows7-Template virtual machine into a template.
a. Right-click the Windows7-Template virtual machine and click Convert to Template.
b. Click Convert in the Convert VM to Template warning.
Since the Windows7-Template virtual machine is already in a Sysprepped state, it is ready to be
converted into a template without any additional work.

3. Shut down the CentOSLinuxServer-Template virtual machine and convert it into a template.
a. Right-click the CentOSLinuxServer-Template virtual machine and click Shut Down.
b. Click Yes to confirm.

Wait for the shutdown process to complete.
c. Right-click the CentOSLinuxServer-Template virtual machine and click Convert to

Template.
d. Click Convert in the Convert VM to Template warning.
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Exercise 5-4: Creating a Windows Virtual
Machine From Template

Scenario

The Quality Assurance team needs to use Provisioning Services to create identical instances of
virtual machines to perform testing on the latest compression algorithms improvements engineered
in the company.

You need to prepare a Windows Server 2008 R2 for the Provisioning Services installation. To make
it easy you want to use the new template you just created.

Although the XenServer Tools were installed on this virtual machine before it was
converted to template, the sysprep process is destructive and removed several key
XenServer drivers. You will need to run the XenServer Tools installer again to reinstall
these drivers.

Before You Begin

To begin this lab, ensure that the following virtual machines are started:

• DomainController
• LicenseServerVPX
• Router

Estimated time to complete this exercise: 10 minutes

Deploying a New Virtual Machine from a Template
1. Create a new virtual machine from the WindowsServer2008R2-Template template called

ProvisioningServicesHost-1 .
a. Right-click WindowsServer2008R2-Template and click New VM Wizard.
b. Select the WindowsServer2008R2-Template template and click Next.
c. Type ProvisioningServicesHost-1 in the Name field and click Next.

2. Do not specify any installation media and don't assign the virtual machine a home server.
a. Leave <empty> as the Installation Media and click Next.
b. Select Don't assign this VM a home server and click Next.

3. Use the template default vCPU, and Memory settings. Specify to use a storage-level fast disk
clone and to place the disk on the shared VM storage.
a. Accept the default values for the vCPUs and Memory fields and click Next.
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b. Ensure that Shared VM Storage is selected as the virtual disk location.
c. Ensure that Use storage-level fast disk clone is selected and click Next.

4. Ensure vLAN Network is the only virtual network interface that will be added and finish the
New VM wizard specifying for it to start automatically.
a. Verify that vLAN Network is selected and click Next.
b. Verify that Start the new VM automatically is selected and that all virtual machine

properties are correct.
c. Click Finish.

Recovering from Sysprep and Joining the Domain
1. View the ProvisioningServicesHost-1 virtual machine console and allow the system to recover

from Sysprep.
a. Click the ProvisioningServicesHost-1 virtual machine and click the Console tab.
b. Wait for the virtual machine to begin the Windows setup wizard. This may take several

minutes.
2. Use the default country, time, keyboard layout settings and respond to the license terms.

a. Accept the defaults for Country or region, Time and currency, and Keyboard layout and
click Next.

b. Respond to the license terms and click Start.
3. Change the Administrator's password to Password1. Allow the virtual machine to log on to the

desktop.
a. Click OK.
b. Type Password1 in the password and confirm password fields.
c. Press Enter and then click OK.

4. Configure the ProvisioningServicesHost-1 's computer name to be "PSH-1" and the domain
cch.local.
a. Click Provide computer name and domain in the Initial Configuration Tasks window.
b. Click Change in the Computer Name tab.
c. Type PSH-1 in the Computer name field.
d. Select Domain, type cch.local , and click OK.

5. Use the CCH\CitrixAdmin credentials to authorize the join. Close all open windows but do
NOT restart the virtual machine.
a. Log on to the cch.local domain using the CCH\CitrixAdmin credentials and click OK.
b. Click OK to dismiss the welcome message.
c. Click OK to acknowledge the changes will not take effect until after the virtual machine is

restarted.
d. Close all open windows, and choose Restart Later when prompted.
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Reinstalling XenServer Tools on a Windows Virtual Machine
1. Attach the xs-tools.iso to the ProvisioningServicesHost-1 virtual machine and launch the

installer.
a. Select xs-tools.iso from the DVD Drive 1 drop-down menu.
b. Click Run xensetup.exe from the AutoPlay dialog box.

2. Respond to the license agreement and install the tools into their default location. Restart the
virtual machine when prompted.
a. Respond to the license agreement and click Next.
b. Accept the default installation destination and click Install.

Allow the XenServer Tools to install before continuing.
c. Verify that Reboot now is selected and click Finish.
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Exercise 5-5: Adding Additional Resources
to a Virtual Machine

Scenario

When discussing future needs of the environment with a fellow administrator, she reminded you
that Provisioning Services requires shared storage to store the vDisks. Since you did not put an IT
request in for this you may not get the storage space in time. You decide to use the
DomainController virtual machine to temporarily host the vDisk storage for the time being.

Since the DomainController virtual machine does not currently have adequate storage space for the
vDisk storage, you need to add another virtual disk to add additional storage.

You also want to add another virtual CPU to the ProvisioningServicesHost-1 virtual machine to
ensure it has adequate resources.

Before You Begin

To begin this lab, ensure that the following virtual machines are started:

• DomainController
• LicenseServerVPX
• Router
• ProvisioningServicesHost-1

Estimated time to complete this exercise: 10 minutes

Adding a Virtual CPU and Virtual Disk
1. Shut down the ProvisioningServicesHost-1 virtual machine and add another vCPU.

a. Right-click the ProvisioningServicesHost-1 virtual machine and click Shut Down.
b. Click Yes to confirm.
c. Click the General tab and click Properties.
d. Click the CPU category. View the number of vCPUs assigned to the virtual machine.
e. Type 2 in the Number of VCPUs field and click OK.

2. Start the ProvisioningServicesHost-1 virtual machine.
3. View the DomainController virtual machine's storage.

a. Click the DomainController virtual machine and click the Storage tab.
b. View the current virtual disks attached to the virtual machine.

4. Add a new 50 GB virtual disk called "vDisk Storage" onto the Local Storage.

© Copyright 2012 Citrix Systems, Inc. Module 5: Creating and Managing Virtual Machines 53



a. Click Add.
b. Type vDisk Storage in the Name field.
c. Type 50 in the Size field and ensure that GB is selected.
d. Select Local storage and click Add.

Formatting the Virtual Disk
1. View the console of the DomainController virtual machine and log on as the

CCH\CitrixAdmin user.
a. Click the DomainController virtual machine and click the Console tab.
b. Click Send Ctrl+Alt+Del and log on as the CCH\CitrixAdmin user.

2. Launch Server Manager and access the Disk Management console.
a. Click Start > Administrative Tools > Server Manager.
b. Expand the Server Manager (DC) > Storage nodes and click Disk Management.

3. Initialize the Disk 1 disk using the Master Boot Record Partition style and begin creating a new
simple volume.
a. Ensure that Disk 1 is selected.
b. Select MBR (Master Boot Record) and click OK.

4. Use the unallocated area of Disk 1 to create a new simple volume and assign it the drive letter
E.
a. Right-click the Unallocated area for Disk 1 and select New Simple Volume.
b. Click Next and click Next to accept the default volume size.
c. Select Assign the following drive letter, select E, and click Next.

5. Perform a quick format to create the simple NTFS volume called "vDisk Storage".
a. Select Format this volume with the following settings and select NTFS
b. Type vDisk Storage in the Volume label field.
c. Select Perform a quick format and click Next.
d. Click Finish.

6. View the drives and devices attached to the computer. Verify that a new drive exists called
"vDisk Storage" that is approximately 50 GB in size and has drive letter E:.
a. Click Start > Computer
b. Verify vDisk Storage appears as a virtual disk with a 50 GB size and has drive letter E:

7. Close all open windows on the DomainController virtual machine.
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Configuring a Share
1. Access the Advanced Sharing settings for the vDisk Storage (E:) drive and share the folder with

the share name "vDisk_Storage".
a. Right-click vDisk Storage (E:) and click Share With > Advanced Sharing .
b. Click Advanced Sharing.
c. Select Share this folder and type vDisk_Storage in the Share name field.

2. Set the share permissions to grant all Domain Admins full control.
a. Click Permissions and click Add.
b. Type CCH\Domain Admins and click Check Names.
c. Click OK and select Allow for the Full Control permission for CCH\Domain Admins.

3. Apply the settings for the share and then close all open windows on the virtual machine.
a. Click Apply and click OK in the Permissions for vDisk_Storage window.
b. Click Apply and click OK in the Advanced Sharing window.
c. Close all open windows on the virtual machine.
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Exercise 5-6: Integrating XenServer with
Active Directory

Scenario

You are considering using the Active Directory integration features in XenServer to control access
rights of different administrators to the XenServer host.

You want to implement the Active Directory integration to test the functionality. But because you
haven't decided if you will need it, you want to disable it before continuing.

Before You Begin

To begin this lab, ensure that you have the:

• DomainController
• LicenseServerVPX
• ProvisioningServicesHost-1
• Router

Estimated time to complete this exercise: 15 minutes

Enabling Active Directory Authentication
1. In XenCenter, access the XenServer hosts's user information and begin joining the domain.

a. Select your XenServer and click the Users tab.
b. Click Join Domain.

2. Use the CCH\CitrixAdmin credentials to join the domain.
a. Type cch.local in the Domain field.
b. Type CitrixAdmin as the User name and Password1 as the Password.
c. Click OK.

Adding User Accounts and Assigning Rights
1. Add the "CCH\Domain Admins" and "CCH\TestUser" domain accounts as administrators to

the XenServer Host.
a. Click Add.
b. Type CCH\Domain Admins, CCH\TestUser.

If testuser is not available, use guest as an alternative.
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c. Click Grant Access and click Close.
2. Change the role of the CCH\Domain Admins to grant Pool Admin access.

a. Click CCH\Domain Admins in the Users and Groups with Access list and click Change
Role.

b. Select Pool Admin and click Save.
3. Change the role of the TestUser to grant VM Operator access.

a. Click TestUser and click Change Role.
b. Select VM Operator and click Save.

Verifying User Roles and Leaving the Domain
1. Reconnect to XenCenter as the CCH\TestUser user.

a. Right-click your XenServer and select Reconnect As
b. Log on using the CCH\TestUser/Password1 credentials.

You will be connected to the XenServer host as the testuser account.
2. Attempt to view the XenServer host server and DomainController virtual machine consoles.

a. Click XenServer and click the Console tab.
You are prompted with a warning that your current role is not authorized to perform this
action. This will verify that the access for the account has been set appropriately.

b. Click the DomainController virtual machine and click the Console tab.
You are able to view and interact with the virtual machine, but not the host.

3. Reconnect to the XenServer Host as the root user.
a. Right-click XenServer and select Reconnect As
b. Log on as the root/Password1 account.

You will be connected to XenServer host as the root account.
4. Leave the CCH.local domain using the CitrixAdmin credentials.

a. Select XenServer and click the Users tab.
b. Click Leave Domain.
c. Click Yes on the warning message.
d. Enter the CitrixAdmin credentials and click Disable.

XenServer is removed from the domain.
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Exercise 6-1: Installing Provisioning Services

Scenario

Now that the basic requirements of the XenServer Host are configured you want to start creating
the Provisioning Services Host to begin working on the requirements of the Quality Assurance
team.

Previously you prepared a Windows Server 2008 R2 virtual machine for use as the Provisioning
Services Host. You need to install the Provisioning Services Host software onto the virtual machine
along with all of the prerequisites like the .Net 3.5 framework.

Before You Begin

To begin this lab, ensure that the following virtual machines are started:

• Router
• DomainController
• LicenseServerVPX
• ProvisioningServicesHost-1

Estimated time to complete this exercise: 25 minutes

Installing Microsoft .NET Framework
1. View the console of the ProvisioningServicesHost-1 virtual machine and logon as the as the

CCH\CitrixAdmin user.
a. Click the ProvisioningServicesHost-1 virtual machine and click the Console tab.
b. Log on to the virtual machine as the CCH\CitrixAdmin user.

2. Launch the Server Manager begin adding a new server feature.
a. Click Start > Administrative Tools > Server Manager.
b. Click the Features node and click Add Features from within the Features Summary menu.

3. Install the .NET Framework 3.5.1 feature without installing WCF activation feature, begin the
installation and allow for the installation to be completed.
a. Expand the .NET Framework 3.5.1 Features node and select .NET Framework 3.5.1.
b. Click Next and then click Install.

After a few moments, the installation completes.
c. Click Close.

4. Close all open windows on the ProvisioningServicesHost-1 virtual machine.
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Installing the Provisioning Services Console
1. Attach the PVS_6.0.iso to the ProvisioningServicesHost-1 virtual machine. Launch the setup

wizard and begin the console installation process.
a. Select the PVS_6.0.iso file in the DVD Drive menu above the console.
b. Click Run autorun.exe to start the setup.
c. Click Console Installation.

2. Install the Host PowerShell Snap-In x64
a. Click Install to install the Host PowerShell SnapIn.

The Citrix Host Snap-In screen appears.
b. Respond to the license agreement and click Install.
c. Click Finish to exit the setup wizard.

3. Install the Broker Snap-In x64.
a. Respond to the license agreement and click Install.
b. Click Finish to exit the setup wizard.

4. Begin the Citrix Provisioning Services Console installation and respond to the license
agreement.
a. Click Next to install the Citrix Provisioning Services Console.
b. Respond to the license agreement and click Next.

5. Use CitrixAdmin as the User Name, CCH as the Organization and the default destination
folder.
a. Type CitrixAdmin in the username field.
b. Type CCH in the Organization field and click Next.
c. Click Next to accept the default destination folder.

6. Use the default setup type and complete the installation.
a. Click Next to accept the default complete setup type.
b. Click Install and, once completed, click Finish.

Installing Provisioning Services
1. Begin the Server Installation. When prompted, allow the installation of SQLncx64.

a. Click Server Installation.
b. Click Install Server.

The InstallShield Wizard appears.
c. Click Install.

A notice appears asking you to verify an optional SQLncx64 installation.
d. Click Yes and then confirm the installation of the SQLncx64.
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2. Begin the Provisioning Services Installation and accept the terms in the license agreement.
a. Click Next in the Citrix Provisioning Services x64 Installation Wizard.
b. Respond to the license agreement and click Next.

3. Use CitrixAdmin as the User Name, CCH as the Organization and the default destination
folder.
a. Type CitrixAdmin in the username field.
b. Type CCH in the Organization field and click Next.
c. Click Next to accept the default destination folder.

4. Use the default setup type and complete the installation.
a. Click Next to accept the default complete setup type.
b. Click Install and, once completed, click Finish.
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Exercise 6-2: Configuring Provisioning
Services

Scenario

You recently installed Provisioning Services on to the ProvisioningServicesHost-1 virtual machine
and now you need to configure it.

In preparation you had the company's database administrator create a database self-contained to
your environment on the DomainController virtual machine. Since you already have DHCP
services running within your network, you only want to install the TFTP services to run on the
Provisioning Server Host.

Before You Begin

To begin this lab, ensure that the following virtual machines are started:

• DomainController
• LicenseServerVPX
• ProvisioningServicesHost-1
• Router

Estimated time to complete this exercise: 20 minutes

Configuring Provisioning Services
1. Begin the Provisioning Services Configuration Wizard on the ProvisioningServicesHost-1

virtual machine. Use the DHCP service on another computer but enabling the PXE service on
ProvisioningServicesHost-1 .
a. Click Next in Provisioning Services Configuration Wizard to begin configuring

Provisioning Services.
b. Select The service that runs on another computer and click Next.
c. Select The service that runs on this computer and click Next to enable the PXE service

on the ProvisioningServicesHost-1 virtual machine.
2. Create a new farm using the SQLEXPRESS instance name on the DC server.

a. Ensure that Create Farm is selected and click Next.
b. Click Browse, select the DC/SQLEXPRESS instance, and click OK.
c. Click Next to accept the database server settings.

3. Enter additional farm configuration information below. Use Active Directory groups and make
the "cch.local/Users/Domain Admins" the administrator group.
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• Database name: ProvisioningServices
• Farm name: CCH
• Site name: SanFrancisco
• Collection name: QualityAssuranceLab
a. Enter the information listed above where required.
b. Ensure that Use Active Directory groups for security is selected.
c. Select cch.local/Users/Domain Admins from the Farm Administrator group and click

Next.
4. Use "vDisk Store" as the Store name located at \\dc\vDisk_Storage.

a. Type vDisk Store in the Store name field and click Browse.
b. Type \\dc\vDisk_Storage in the Default path field.
c. Click Next to proceed.

5. Specify "10.10.<X>.50" as the hostname, replacing <X> with the server ID in your student
reference guide. Validate the license server version and communication.
a. Type 10.10.<X>.50 in the License server name field.

Replace <X> with the server ID in the student reference guide.
b. Select Validate license server version and communication and click Next.

6. Specify the CCH\CitrixAdmin credentials and configure the database for the account.
a. Select Specified user account and type CitrixAdmin in the User name field.
b. Type cch.local in the Domain field.
c. Type Password1 in the Password and Confirm password fields.
d. Select Configure the database for the account and click Next.

7. Use the default Active Directory Computer Account Password and Network Communication
settings.
a. Verify that the Automate computer account password updates is checked and click Next.
b. Click Next to accept the default nework communication settings.

8. Specify to use the Provisioning Server TFTP service. Use the default stream servers boot list
settings and finish the wizard allowing the wizard to automatically start the services.
a. Select Use the Provisioning Services TFTP service and click Next.
b. Click Next to accept the default stream servers boot settings.
c. Click Finish to apply all configuration settings.
d. Click OK in the firewall dialog and click Done once the configuration is completed.

9. Close all open windows on the ProvisioningServicesHost-1 virtual machine.
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Exercise 6-3: Configuring Delegated
Administration

Scenario

You recently configured a new Provisioning Service farm. Now you need to connect to the farm
and set up delegated administration to allow all Domain Admins to administrate the farm.

Before You Begin

To begin this lab, ensure that the following virtual machines are started:

• DomainController
• LicenseServerVPX
• ProvisioningServicesHost-1
• Router

Estimated time to complete this exercise: 15 minutes

Connecting to the Farm
1. Launch the Provisioning Services Console from the ProvisioningServicesHost-1 virtual machine

and begin connecting to the farm.
a. Click Start > All Programs > Citrix > Provisioning Services > Provisioning Services

Console.
b. Right-click the Provisioning Services Console node and click Connect to Farm.

2. Use PSH-1 as Name of the server, specify to auto-login in the future, and connect to the farm
using the windows credentials.
a. Type PSH-1 in the Name field.
b. Ensure that Use my Windows credentials to login is selected.
c. Select Auto-login on application start or reconnect and click Connect.

Configuring Delegated Administration
1. View the group properties of the CCH farm.

a. Right-click the CCH (PSH-1) node and click Properties.
The Farm Properties dialog box opens.

b. Click the Groups tab.
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2. Add the "cch.local/Users/Domain Users" group to the CCH (PS-1) farm.
a. Click Add.
b. Click Search to view a list of groups and select the cch.local/Users/Domain Users group

from the list.
c. Click OK to close the Add System Groups dialog box.
d. Click OK to close the Farm Properties dialog box.

3. View the SanFrancisco site security properties.
a. Expand the CCH (PS-1) > Sites > SanFrancisco node.
b. Right-click the San Francisco node then click Properties.
c. Click the Security tab.

4. Add the "cch.local/Users/Domain Admins" as a Site Administrator.
a. Click Add.
b. Select the cch.local/Users/Domain Admins group and click OK.
c. Click OK to close the Site Properties dialog box.

5. View the QualityAssuranceLab device collection security properties.
a. Expand the Device Collections node.
b. Right-click the QualityAssuranceLab node and click Properties.

6. Add the "cch.local/Users/Domain Admins" group as a device administrator groups to the CCH
(PSH-1) farm.
a. Click the Security tab and click the Add button under Groups with 'Device

Administrator' access.
The Add Security Groups dialog box opens.

b. Select the cch.local/Users/Domain Admins group and click OK.
c. Click OK.
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Exercise 6-4: Adding a Provisioning Services
Host to the Farm

Scenario

Eventually you want to set up load balancing for your Provisioning Service farm. So in preparation
you want to add another Provisioning Services Host to the farm. Another administrator set up a
virtual disk and placed it onto your shared storage. This virtual disk contains a Windows Server
2008 R2 system that is already joined to the Active Directory domain and has Provisioning Services
installed.

You need to create a virtual machine for this virtual disk and then add it to the Provisioning
Services farm.

Before You Begin

To begin this lab, ensure that the following virtual machines are started:

• DomainController
• LicenseServerVPX
• ProvisioningServicesHost-1
• Router

Estimated time to complete this exercise: 30 minutes

Creating a Diskless Virtual Machine
1. Launch the New VM wizard on your XenServer Host.

a. Select XenServer.
b. Click New VM on the toolbar.

The New VM wizard launches.
2. Use the Windows Server 2008 R2 (64-bit) template to create a virtual machine named

ProvisioningServicesHost-2 .
a. Select the Windows Server 2008 R2(64-bit) template and click Next.
b. Type ProvisioningServicesHost-2 in the Name field and click Next.

3. Specify for the virtual machine to boot from the network and use the default home server.
a. Select Boot from network and click Next.
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Though this virtual machine will not be starting from the network, this option must be
specified to create a diskless virtual machine.

b. Click Next to accept the default home server.
4. Specify 2 vCPUs and change the memory to 1536 MB. Specify to create a diskless VM.

a. Type 2 in the Number of vCPUs field.
b. Type 1536 in the Memory field and click Next.
c. Verify that Create a diskless VM that boots from the network is selected and click Next.

5. Ensure vLAN Network is the only virtual network interface that will be added and finish the
New VM wizard specifying for it to start automatically.
a. Verify that vLAN Network is selected and click Next.
b. Verify that Start the new VM automatically is selected and that all virtual machine

properties are correct.
c. Click Finish.

Adding an Existing Virtual Hard Disk from Shared Storage
1. View the ProvisioningServicesHost-2 virtual machine's boot order.

a. Right-click the ProvisioningServicesHost-2 virtual machine and select Properties.
b. Click Boot Options.

2. Set the boot order to first boot from DVD-Drive and then from Hard Disk. Disable booting
from the Network.
a. Select Network and click Move Down two times to set it last in the Boot order.
b. Ensure the checkbox for Network is deselected.
c. Ensure that the DVD-Drive and Hard Disk checkboxes are selected and click OK.

3. Attach the (No Name) 50GB disk from the Shared VM Storage to the
ProvisioningServicesHost-2 virtual machine.
a. Click the Storage tab and click Attach.
b. Select the (No Name) 50 GB vDisk from the Shared VM Storage node.
c. Click Attach and click OK.

4. Restart the ProvisioningServicesHost-2 virtual machine and view the console. Ensure that the
virtual machine is starting into Windows Server.
a. Right-click ProvisioningServicesHost-2 virtual machine and click Force Reboot.
b. Click Yes and click the Console tab.
c. Ensure that the virtual machine is now starting into Windows Server 2008 R2.

© Copyright 2012 Citrix Systems, Inc. Module 6: Installing and Configuring Provisioning Services 69



Adding a Provisioning Services Host to the Farm
1. Log on to the ProvisioningServicesHost-2 virtual machine as the CCH\CitrixAdmin user.
2. Launch the Provisioning Services Configuration Wizard and begin the configuration.

a. Click Start > All Programs > Citrix > Provisioning Services > Provisioning Services
Configuration Wizard.

b. Click Next.
3. Set the DCHP and PXE to use the service on another computer and join an existing farm.

a. Select The service that runs on another computer and click Next.
b. Select The service that runs on this computer and click Next to enable the PXE service.
c. Select Join existing farm and click Next.

4. Add the existing SQLEXPRESS database to the configuration.
a. Click Browse, select the DC/SQLEXPRESS instance, and click OK.
b. Click Next to accept the database server settings.

5. Specify to use the ProvisioningServices:CCH farm, the existing SanFrancisco site, and the
existing store.
a. Click Next to accept the default ProvisioningServices:CCH farm name.
b. Click Next to accept the default Existing site.
c. Click Next to accept the default Existing store.

6. Specify the CCH\CitrixAdmin credentials and configure the database for the account.
a. Select Specified user account and type CitrixAdmin in the User name field.
b. Type cch.local in the Domain field.
c. Type Password1 in the Password and Confirm password fields.
d. Select Configure the database for the account and click Next.

7. Use the default Active Directory Computer Account Password and Network Communication
settings.
a. Verify that the Automate computer account password updates is checked and click Next.
b. Click Next to accept the default nework communication settings.

8. Specify to use the Provisioning Server TFTP service. Use the default stream servers boot list
settings and finish the wizard allowing the wizard to automatically start the services.
a. Select Use the Provisioning Services TFTP service and click Next.
b. Click Next to accept the default stream servers boot settings.
c. Click Finish to apply all configuration settings.
d. Click OK in the firewall dialog and click Done once the configuration is completed.

9. Use XenCenter to restart the ProvisioningServicesHost-1 and ProvisioningServicesHost-2
virtual machines.
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Exercise 7-1: Configuring the Master Target
Device

Scenario

The Quality Assurance team needs to perform their testing using identical Windows 7 virtual
machines. In order to meet this need you need to create a Windows 7 vDisk for use with
Provisioning Services.

You decided to use your Windows 7 template to create this first version of the vDisk and update it
as needed later. You need to create a new Windows 7 virtual machine from template and then
prepare it to be a target device by installing the target device software.

Before You Begin

To begin this lab, ensure that the following virtual machines are started:

• DomainController
• LicenseServerVPX
• ProvisioningServicesHost-1
• ProvisioningServicesHost-2
• Router

Estimated time to complete this exercise: 20 minutes

Preparing a Windows 7 Target Device
1. Use the Windows7-Template template to create a new virtual machine called

ProvisioningTarget .
a. Right-click Windows7-Template and click New VM Wizard.
b. Select the Windows7-Template template and click Next.
c. Type ProvisioningTarget for the new virtual machine and click Next.

2. Do not specify any installation media and don't assign the virtual machine a home server.
a. Leave <empty> as the Installation Media and click Next.
b. Select Don't assign this VM a home server and click Next.

3. Use the template default vCPU, and Memory settings. Specify to use a storage-level fast disk
clone and to place the disk on the shared VM storage.
a. Accept the default values for the vCPUs and Memory fields and click Next.
b. Ensure that Shared VM Storage is selected as the virtual disk location.

© Copyright 2012 Citrix Systems, Inc. Module 7: Managing vDisks and Target Devices 73



c. Ensure that Use storage-level fast disk clone is selected and click Next.
4. Ensure vLAN Network is the only virtual network interface that will be added and finish the

New VM wizard. Do not specify for the new virtual machine to start automatically.
a. Verify that vLAN Network is selected and click Next.
b. Deselect the Start the new VM automatically option.
c. Click Finish.

5. View the Networking virtual interface information for the ProvisioningTarget virtual machine.
a. Select the ProvisioningTarget virtual machine in the XenCenter console.
b. Click the Networking tab.

6. Set the MAC address of the virtual network interface to "a2:f6:76:c6:79:77".
a. Select the 0 network device and click Properties.
b. Click Use this MAC Address and type a2:f6:76:c6:79:77.
c. Click OK.

7. Start the ProvisioningTarget virtual machine and view its console. Allow the virtual machine to
recover from sysprep.
a. Click Start to start the virtual machine.
b. Click the Console tab.
c. View the virtual machine console as it recovers from sysprep.

8. Use the default country, time, and keyboard settings. Use the username "Win7Admin" leaving
the computer name as it appears. Use "Password1" as the password and password hint.
a. Click Next to accept the default values for the Country or region, Time and currency, and

Keyboard layout fields.
b. Type Win7Admin in the Type a user name field and click Next.
c. Type Password1 in the Type a password and Retype your password fields.
d. Type Password1 in the Type a password hint field and click Next.

9. Respond to the license agreement and specify ask you later about software updates. Keep the
default time settings and specify to use the work network settings. Wait for the virtual machine
to load the desktop before continuing.
a. Respond to the license terms and click Next.
a. Select Ask me later.
b. Accept the Time zone defaults and click Next.
c. Click Work Network.
d. Wait for the virtual machine to load the desktop before continuing.

10. Attach the xs-tools.iso to the ProvisioningTarget virtual machine and launch the installer.
a. Select xs-tools.iso from the DVD Drive 1 drop-down menu in XenCenter.
b. Click Run Xensetup.exe from the Autoplay dialog box in the virtual machine console.
c. Click Yes in the User Account Control dialog.
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11. Respond to the license agreement and install the tools into their default location. Restart the
virtual machine when prompted.
a. Respond to the license agreement and click Next.
b. Accept the default installation destination and click Install.

Allow the XenServer Tools to install before continuing.
c. Verify that Reboot now is selected and click Finish.

Installing Provisioning Services Target Device Software
1. Log on to the ProvisioningTarget virtual machine as the Win7Admin user.
2. Attach the PVS_6.0.iso media to the ProvisioningTarget virtual machine and launch the

setup screen from the DVD media. Begin the target device installation process.
a. Select the PVS_6.0.iso file in the DVD Drive 1 drop-down menu above the console.
b. Click Run autorun.exe to start the setup.
c. Click Yes in the User Account Control dialog box.
d. Click Target Device Installation.

3. Start the Provisioning Services target device installation.
a. Click Target Device Installation and click Next in the Welcome screen.
b. Respond to the license agreement and click Next.

4. Use CitrixAdmin as the User Name, CCH as the Organization and the default destination
folder.
a. Type CitrixAdmin in the username field.
b. Type CCH in the Organization field and click Next.
c. Click Next to accept the default destination folder.

5. Complete the Install and close the Installation wizard without restarting or launching the
imaging wizard.
a. Click Install to begin installation.
b. Deselect the Launch Imaging Wizard check box and click Finish to complete the

installation.
c. Click No to verify the restart of the virtual machine.

6. Shut down the ProvisioningTarget virtual machine.
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Exercise 7-2: Creating a vDisk

Scenario

You recently prepared a Windows 7 virtual machine for use as a Provisioning Service vDisk. Now
you need to create the vDisk from this virtual machine and transfer the contents of the virtual
machine's virtual hard disk onto the vDisk.

Before You Begin

To begin this lab, ensure that the following virtual machines are started:

• DomainController
• LicenseServerVPX
• ProvisioningServicesHost-1
• ProvisioningServicesHost-2
• Router

Estimated time to complete this exercise: 30 minutes

Configuring a Virtual Machine to PXE Boot
1. View the boot options properties of the ProvisioningTarget virtual machine in XenCenter.

a. Click the ProvisioningTarget virtual machine in the XenCenter.
b. Click the General tab and click Properties.
c. Click Boot Options.

2. Configure the ProvisioningTarget virtual machine to PXE boot upon startup.
a. Select Network in the Boot order field and click Move Up until Network is at the top of

the list.
b. Deselect Hard Disk.
c. Click OK to close ProvisioningTarget Properties dialog box.

3. Start the ProvisioningTarget virtual machine and view its console. Allow the virtual machine to
boot from the local hard drive.
a. Select the ProvisioningTarget virtual machine and click Start.
b. Click the Console tab and view the virtual machine start.
c. When prompted type any key to allow ProvisioningTarget to boot from local hard drive.

76 Module 7: Managing vDisks and Target Devices © Copyright 2012 Citrix Systems, Inc.



Using the Provisioning Services Imaging Wizard to Create a
vDisk
1. Log on to the ProvisioningTarget virtual machine as the Win7Admin user.
2. Launch and begin the Imaging Wizard.

a. Click Start > All Programs > Citrix > Provisioning Services > Imaging Wizard
The Provisioning Services Imaging Wizard opens.

b. Click Yes in the User Account Control dialog box.
c. Click Next to begin the wizard.

3. Connect to the PSH-1 server using the CCH\CitrixAdmin credentials.
a. Type PSH-1 in the server field and select Use these credentials.
b. Enter the CCH\CitrixAdmin credentials and click Next.

4. Create a new vDisk called Windows7 on the vDisk Store store using a dynamic VHD type.
a. Select Create new vDisk and click Next.
b. Type Windows7 in the vDisk name field.
c. Select Dynamic as the VHD type and click Next.

5. Do not select any volume licensing and use the default image volume configuration.
a. Select None and click Next.
b. Click Next to accept the default Image Volume configuration.

6. Name the target device Win7TestVM and optimize it for Provisioning Services before finishing
the Imaging Wizard.
a. Type Win7TestVM in the Target device name field and click Next.
b. Click Optimize for Provisioning Services and click OK.
c. Click Finish and click Yes to restart the virtual machine.

The restart process may take a few minutes to initially connect.
7. Log on to the ProvisioningTarget virtual machine as the Win7Admin user.
8. Allow XenConvert to convert files from the local volume to the provisioning server and then

shut down the ProvisioningTarget virtual machine.
a. Allow XenConvert to complete.

This process may take several minutes to complete.

b. Click Finish.
c. Click Shutdown to shutdown the virtual machine.
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Verifying the vDisk Image
1. Use XenCenter to rename the hard disk attached to the ProvisioningTarget virtual machine to

"Windows7-TargetBase" and then detach the hard disk .
a. Click ProvisioningTarget and click the Storage tab.
b. Click the virtual disk in the 0 position and click Properties.
c. Type Windows7-TargetBase in the name field and click OK.
d. Click Detach and click Yes to confirm.

2. View the console of the ProvisioningServicesHost-1 virtual machine and log on as the
CCH\CitrixAdmin user.
a. Click ProvisioningServicesHost-1 and click the Console tab.
b. Click Send Ctrl+Alt+Del and log on as the CCH\CitrixAdmin user.

3. Launch the Provisioning Services Console from the ProvisioningServicesHost-1 virtual machine
and begin connecting to the farm.
a. Click Start > All Programs > Citrix > Provisioning Services > Provisioning Services

Console.
b. Right-click the Provisioning Services Console node and click Connect to Farm.

4. Use PSH-1 as Name of the server, specify to auto-login in the future, and connect to the farm
using the windows credentials.
a. Type PSH-1 in the Name field.
b. Ensure that Use my Windows credentials to login is selected.
c. Select Auto-login on application start or reconnect and click Connect.

5. View the QualityAssuranceLab collection in the Provisioning Services Console.
a. Expand the CCH (PSH-1) > Sites > SanFrancisco > Device Collections node is expanded.
b. Click QualityAssuranceLab.

6. Access the Win7TestVM properties and set it to boot from the vDisk.
a. Right-click Win7TestVM and select Properties.
b. Select vDisk in the Boot from field.
c. Click OK.

7. Start the ProvisioningTarget virtual machine and log on as the Win7Admin user.
a. Right-click ProvisioningTarget and click Start.
b. Click the Console tab and allow the virtual machine to start.

Although the virtual disk was removed from the ProvisioningTarget virtual machine, it
starts normally because it is booting from the vDisk on the Provisioning Services Host.

c. Log on as the Win7Admin user.
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8. View the Virtual Disk settings and confirm that the vDisk is Active and booted from the
Windows7.vhd vDisk and then shut down the ProvisioningTarget virtual machine.
a. Right-click the Virtual Disk icon in the System Tray and click Virtual Disk Status.
b. Verify that the vDisk is Windows7.vhd and is Active.
c. Click Shutdown to shutdown the virtual machine.
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Exercise 7-3: Preparing the vDisk for Mass
Deployment

Scenario

You previously created a vDisk containing Windows 7. Now you want to set this vDisk as a read
only vDisk that all target devices can use.

You need to set the vDisk to Standard Image mode and then create a target device template to use
as a base for future target devices.

Before You Begin

• DomainController
• LicenseServerVPX
• ProvisioningServicesHost-1
• ProvisioningServicesHost-2
• Router

Estimated time to complete this exercise: 10 minutes

Setting the vDisk to Standard Image Mode
1. View the console of the ProvisioningServicesHost-1 virtual machine and access the properties

of the Windows7 vDisk.
a. Click the ProvisioningServicesHost-1 virtual machine and click the Console tab.
b. Click the vDisk Pool node in the Provisioning Services Console.
c. Right-click Windows7 and select Properties.

2. Change the access mode of the vDisk to Standard Image mode and enable active directory
machine account password management.
a. Select Standard Image (multi-device, read-only access) from the Access mode menu.
b. Select Enable Active Directory machine account password management.
c. Click OK.

3. Access the Win7TestVM target device settings and change the name to Win7Template. Set it as
the template of the collection.
a. Expand the CCH (PSH-1) > Sites > SanFrancisco > Device Collections node and click

QualityAssuranceLab.
b. Right-click Win7TestVM and select Properties.
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c. Type Win7Template in the Name field and click OK.
d. Right-click Win7Template, click Set Device as Template and click Yes.

4. Use XenCenter to convert the ProvisioningTarget virtual machine into a template.
a. Right-click the ProvisioningTarget virtual machine in XenCenter and select Convert to

Template.

Ensure that the ProvisioningTarget virtual machine is shut down.

b. Click Convert.
5. Rename the ProvisioningTarget template to QA-System.

a. Click Properties in the General tab of the ProvisioningTarget template.
b. Type QA-System in the Name field and click OK.

Configuring Target Device for Auto-Add
1. View the ProvisioningServicesHost-1 virtual machine's console.
2. Use the Provisioning Services Console to begin the Auto-Add wizard on the

QualityAssuranceLab collection.
a. Right-click the QualityAssuranceLab node and select Auto-Add Wizard.
b. Click Next.

3. Enable Auto-Add on the QualityAssuranceLab collection of the SanFrancisco site using the
Win7Template properties as base.
a. Select Enable auto-add and click Next.
b. Select SanFrancisco from the Site field and click Next.
c. Select QualityAssuranceLab from the Collection field and click Next.
d. Select Win7Template from the Template field and click Next.

4. Configure the Automatic Device Naming to have the prefix "Win7Test" and use 3 number
lengths with zero fill and then finish the wizard.
a. Type Win7Test in the Prefix field.
b. Type 3 in the Length field.
c. Ensure that Zero fill is selected and click Next.
d. Click Finish.

5. Use XenCenter to provision 6 quick clones of the QA-System virtual machine and allow them
to boot from the Provisioning Server.
a. Right-click the QA-System template in XenCenter and select Quick Create.
b. Repeat sub-step a five more times for a total of 6 quick clones.
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6. View the consoles of each quick clone to verify that they are correctly PXE booting into
Windows.

Since QA-System virtual machines do not have any virtual hard disks attached that
contain a Windows operating system, if the virtual machine it is booting into Windows
successfully, it must be PXE booting correctly.

7. View the ProvisioningServicesHost-1 virtual machine's console, refresh the
QualityAssuranceLab collection and ensure that 6 new target device entries now exist.
a. Click ProvisioningServicesHost-1 and click the Console tab.
b. Right-click QualityAssuranceLab and click Refresh.
c. Verify that 6 new target devices now exist.

82 Module 7: Managing vDisks and Target Devices © Copyright 2012 Citrix Systems, Inc.



Exercise 7-4: Updating vDisks to Add Active
Directory Integration

Scenario

When you looked at the build plan for the environment you forgot that the Windows 7 vDisk
needed to be added to Active Directory. Now you need to update the virtual disk to add the vDisk
to Active Directory and configure machine accounts for each new target device.

Before You Begin

To begin this lab, ensure that the following virtual machines are started:

• DomainController
• LicenseServerVPX
• ProvisioningServicesHost-1
• ProvisioningServicesHost-2
• Router
• QA-System (1) - QA-System (6)

Estimated time to complete this exercise: 35 minutes

Configuring the vDisk for Automatic Updates
1. Use XenCenter to shutdown the QA-System (1) through QA-System (6) virtual machines.

a. In XenCenter, select the QA-System (1) virtual machine.
b. Shift-click the QA-System (6) virtual machine to select all virtual machines in between.
c. Click Shut Down and click Yes.
Please wait for all virtual machines to shut down completely before continuing.

2. View the console of the ProvisioningServicesHost-1 virtual machine and access the vDisk Pool
on the Provisioning Services Console.
a. Click ProvisioningServicesHost-1 and click the Console tab.
b. Click vDisk Pool in the Provisioning Service Console.

3. View the Auto Update properties of the Windows 7 vDisk and enable Auto Update.
a. Right-click Windows7 and click Properties.
b. Click the Auto Update tab and select Enable automatic updates for this vDisk.
c. Click OK.

4. Use XenCenter to start the QA-System (1) through QA-System (6) virtual machines.
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a. In XenCenter, select the QA-System (1) virtual machine.
b. Shift-click the QA-System (6) virtual machine to select all virtual machines in between.
c. Click Start.

Creating and Updating a New vDisk version
1. View the console of the ProvisioningServicesHost-1 virtual machine and access the vDisk Pool

on the Provisioning Services Console.
a. Click ProvisioningServicesHost-1 and click the Console tab.
b. Click vDisk Pool in the Provisioning Service Console.

2. Add a new version to the Windows 7 vDisk.
a. Right-click Windows 7 and select Versions.
b. Click New and click Done.

3. Set Win7Test001 target device to maintenance type.
a. Click QualityAssuranceLabs.
b. Right-click Win7Test001 and select Properties.
c. Select Maintenance in the Type drop-down menu and click OK.

4. Use XenCenter to restart the QA-System (1) and boot up off the Windows 7.1 [maint] vDisk.
a. In XenCenter, Right-click QA-System (1), click Reboot and click the Console tab.
b. Type 1 and press Enter.

5. Log on to the QA-System (1) virtual machine as the Win7Admin user. View the target devices
settings to ensure that the disk is in read/write mode and close all open windows.
a. Log on as the Win7Admin user.
b. Click the arrow in the notification area, right-click the Virtual Disk icon and click Virtual

Disk Status.
c. Ensure that the virtual disk listed is "Windows7.1.avhd" and that it is in read/write mode.
d. Close all open windows on the QA-System (1) virtual machine.

Joining the Domain
1. Access the computer properties and begin changing the computer name and domain settings.

a. Click Start, right-click Computer and select Properties.
b. Click Change settings and click Change.

2. Change the domain to cch.local using the CCH\CitrixAdmin credentials.
a. Select Domain from the Member of field, type cch.local, and click OK.
b. Authenticate with the CCH domain using the CitrixAdmin/Password1 credentials and

click OK once the join is confirmed.
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c. Click OK.
3. Close all open windows on the QA-System (1) virtual machine and restart the virtual machine

when prompted.
4. Start up from the Windows 7.1 [maint] and log on as the CCH\CitrixAdmin user.

a. Type 1 and press Enter.
b. Log on as the CCH\CitrixAdmin user.

5. Verify that the domain join was successful and then shut down the QA-System (1) virtual
machine.
a. Click Start, right-click Computer and select Properties.
b. Verify that the full computer name is listed as win7test001.cch.local.
c. Click Shut Down to shut down the virtual machine.

6. View the console of the DomainController virtual machine and log on as the
CCH\CitrixAdmin user.

7. Use the Active Directory Users and Computers console to verify that the WIN7TEST001
computer account is listed as a part of the domain.
a. Click Start > Administrative Tools > Active Directory Users and Computers.
b. Click the cch.local > Computers node.
c. Verify that WIN7TEST001 appears in the computer list.

Adding Devices to Active Directory
1. Access the Provisioning Services Console on the ProvisioningServicesHost-1 virtual machine.
2. Create a machine account in Active Directory for Win7Test002-Win7Test006 in the

Provisioning Services Console.
a. Click QualityAssuranceLab to view the collection.
b. Shift-click Win7Test002 and Shift-click Win7Test006 to highlight all of the target devices.
c. Right-click the Win7Test002 device and click Active Directory > Create Machine

Account.
d. Click Create Account.

The Status indicates Success when the device has been added to Active Directory.
e. Click Close.

Promoting the new vDisk Version to Production
1. Set the Win7Test001 target device to Production type.

a. Right-click Win7Test001 and click Properties.
b. Select Production in the type menu and click OK.
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2. View the version information of the Windows 7 vDisk.
a. Click vDisk Pool.
b. Right-click Windows7 and select Versions.

3. Promote the new version of the Windows 7 vDisk immediately to production.
a. Click Version 1 and click Promote.
b. Select Production and ensure Immediate is selected.
c. Click OK and click Done.

Testing Automatic Update
Use the following procedure to test automatic updates.

1. View the console of the QA-System (2) virtual machine and logon as the Win7Admin user.
a. Click QA-System (2) and click Console.
b. Log on to the QA-System(2) as the Win7Admin user.

2. View the virtual disk status of the virtual machine. Verify that it is running the Windows7.vhd
vdisk in Read Only mode.
a. Click the hidden icons arrow on the notification area of the task bar, right-click the virtual

disk icon, and select Virtual Disk Status.
b. Verify that the Virtual Disk field shows the Windows7.vhd file.

3. Use XenCenter to restart the QA-System (2) through QA-System (6) virtual machine.
a. In XenCenter, select the QA-System (2) virtual machine.
b. Shift-click the QA-System (6) virtual machine to select all virtual machines in between.
c. Click Reboot.

4. View the console of the QA-System (2) virtual machine and logon as the CCH\CitrixAdmin
user.
a. Click QA-System (2) and click Console.
b. Log on to the QA-System(2) as the CCH\CitrixAdmin user.

5. View the virtual disk status of the virtual machine. Verify that it is running the
Windows7.1.avhd vdisk in Read Only mode.
a. Click the hidden icons arrow on the notification area of the task bar, right-click the virtual

disk icon, and select Virtual Disk Status.
b. Verify that the Virtual Disk field shows the Windows7.1.avhd file.

6. Start the QA-System (1) virtual machine.
Before the restart, the vDisks were running of off the original version that was not joined to the
domain. However, after rebooting them they immediately took on the new version of the vDisk and
were joined to the domain.
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Exercise 8-1: Creating a Resource Pool

Scenario

A new stakeholder was added to the project which resulted in an expansion of the scope. To
support this change you require more system resources than a single server can offer. Another
XenServer host will be needed to provide adequate computing resources.

In addition to the change in scope, the required completion date has been moved up to this Friday.
To meet these new requirements, you will be teamed with another administrator. The two of you
will have to work together to complete the project on time.

Work with the other administrator to create a resource pool and join both of your servers in the
resource pool.

Going Forward

You will now be paired with another student to complete the rest of the labs. When you are paired
you need to decide on which student will perform each of the following roles:

• Administrator 1: This administrator will use their system to become the pool master. When
the book refers to the master ID, it is referring to this student's XenServer host. You will use
this student's virtual machines only going forward. This student will only perform the tasks
marked as for Administrator 1.

• Administrator 2: This student's XenServer host will be joined to Administrator 1's pool.
During the process it will lose the virtual machines and settings on their host. This student will
only perform the tasks marked as for Administrator 2.

How to decide on roles: Either student can perform the role of Administrator 1 or Administrator
2, but it is recommended that the student that has most closely executed on the exercise workbook's
instructions, or has had the fewest issues, become Administrator 1.

Before You Begin

To begin this lab, ensure that the following virtual machines are started:

• DomainController
• LicenseServerVPX
• ProvisioningServicesHost-1
• ProvisioningServicesHost-2
• Router
• QA-System (1) - QA-System (6)

Estimated time to complete this exercise: 20 minutes
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AdministratorAdministrator 2:2: Preparing a XenServer Host for Addition to
a Pool
1. Shut down all active or suspended virtual machines.

a. Shift-select all running virtual machines.
b. Right-click a virtual machine and click Force Shutdown.

2. Detach and forget the ISO-Library storage repository from your XenServer host.
a. Right-click ISO-library and click Detatch.

Wait for the process to complete.
b. Right-click ISO-library and click Forget.

3. Detach and forget the Shared VM Storage storage repository from your XenServer host.
a. Right-click Shared VM Storage and click Detatch.

Wait for the process to complete.
b. Right-click Shared VM Storage and click Forget.

4. Remove all non-physical server networks.
a. Click XenServer and click Networking.
b. Click vLAN Network, click Remove Network, and click Yes.
c. Perform the previous substep on any network without a MAC address.

5. Please communicate to your partner when this task is completed.

AdministratorAdministrator 11: Creating a Resource Pool
1. Please wait for your partner to indicate that they have completed the previous tasks before

continuing.
2. Create a new resource pool called "CCH QualityAssurance Pool" using your XenServer as the

master.
a. Click New Pool on the toolbar.
b. Type CCH QualityAssurance Pool in the name field and click Create Pool.

The XenServer host is converted to the master of the resource pool. A new top level node
named CCH QualityAssurance Pool, is added. The resource pool contains a single
XenServer host.

The ISO-Library previously created is a shared resource for the resource pool.

3. Add your partner's XenServer to your XenCenter console.
a. Click Add New Server.
b. Type the IP address of your partner's XenServer host in the Server field.
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c. Enter the root\Password1 account and click Add.
4. Add your partner's XenServer host to the pool.

a. Right-click CCH QualityAssurance Pool and click Add Server > XenServer<A2> .
Replace <A2> with the secondary host's ID in Administrator 2's student reference guide.

b. Click Yes.
The second XenServer host is added to Resource Pool. Once the pool-join operation is
complete, the icon turns green and the resource pool contains two servers.

5. Please communicate to your partner when this task is completed.

AdministratorAdministrator 22: Accessing the Resource Pool
1. Please wait for your partner to indicate that they have completed the previous tasks before

continuing.
2. Allow for XenCenter to reconnect to the Pool Master automatically and display the resource

pool.
3. Confirm that both servers are licensed in the License Manager.

a. Click Tools > License Manager .
b. Confirm both XenServer hosts have the same license version.
c. Click Close to close the License Manager.

4. Use XenMotion to migrate the QA-System (4) - QA-System (6) virtual machines from the
XenServer host to the secondary host.
a. Expand both XenServer nodes.
b. Shift-click the QA-System(4) and QA-System(6) virtual machines.
c. Drag the virtual machines to the secondary host and click Yes.
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Exercise 9-1: Configuring the Distributed
Virtual Switch

Scenario

As part of the recent increase in scope, it was determined that several members of the Quality
Assurance team will need to run virtual machines in private networks that can span all current and
future XenServer hosts. Since regular private networks are limited to a single XenServer host, you
need to create a cross-server private network.

To create a cross-server private network you need to install the distributed virtual switch virtual
machine and then configure it to work in the resource pool.

Before You Begin

To begin this lab, ensure that the following virtual machines are started:

• DomainController
• LicenseServerVPX
• ProvisioningServicesHost-1
• ProvisioningServicesHost-2
• Router
• QA-System (1) - QA-System (6)

Estimated time to complete this exercise: 15 minutes

AdministratorAdministrator 22: Importing the Distributed Virtual Switch
1. Launch the Import Wizard on the CCH QualityAssurance Pool.

a. Select CCH QualityAssurance Pool.
b. Click File > Import.

2. Begin the import of the Distributed Virtual Switch virtual appliance from the file XenServer-
6.0-dvsc.xva located in C:\XenServer.
a. Click Browse and browse to C:/XenServer.
b. Select XenServer-6.0-dvsc.xva and click Open .
c. Click Next.

3. Specify that the virtual machine to run on the pool master server using the Shared VM Storage.
a. Select the pool master server as the home server and click Next.
b. Select Shared VM storage as the storage repository and click Import.
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4. Use only a single virtual network interface on the Network0 network and complete the wizard
specifying that the virtual machine start after import.
a. Select Network0 as the default network interface in the Network drop-down list and click

Next.
b. Verify that Start VM(s) after import is selected and click Finish.

The Distributed Virtual Switch virtual appliance may take a few minutes to import.
5. Rename the "DVS Controller 8124 amd64" virtual machine as vSwitchController .

a. Click DVS Controller 8124 amd64.
b. Click the General tab, then click Properties.
c. Type vSwitchController in the Name field and click OK.

AdministratorAdministrator 22: Configuring the Distributed Virtual Switch
1. Log in to the console of the vSwitchController virtual machine using the admin/admin

credentials.
a. Select the vSwitchController virtual machine and click the Console tab.
b. Click on the console window and log on using the admin/admin credentials.

2. Use the "set controller management-interface" command to give the vSwitchController virtual
machine a static IP address of 10.10.<A1>.15, netmask of 255.255.255.0 and default gateway
10.10.<A1>.1, replacing <A1> with the pool master host's ID in Administrator 1's student
reference guide.
a. Type set controller management-interface config static

10.10.<A1>.15 255.255.255.0 10.10.<A1>.1 and press Enter
Replace <A1> with the pool master host's ID in Administrator 1's student reference guide.

3. Use the "show controller management-interface" command to verify the settings are correct
and restart the controller appliance to enable the IP address configuration.
a. Type show controller management-interface and press Enter to confirm the

network settings.
b. Type restart controller appliance and press Enter.

4. Please communicate to your partner when this task is completed.

AdministratorAdministrator 11: Adding an NTP Server to the Distributed
Virtual Switch Controller
1. You can view the status and follow along with your partner's progress by viewing the console

of the vSwitchController once available.
2. Please wait for your partner to indicate that they have completed the previous tasks before

continuing.
3. Access the xsconsole of the pool master XenServer host.
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a. Select the pool master XenServer host, then click the Console tab.
b. Press Enter to access the command prompt.
c. Type xsconsole and press Enter.

4. Access the Network Time settings and write down the IP address.
a. Browse to Network and Management Interface and press Enter.
b. Browse to Network Time (NTP) and note the IP address located in the right pane.

5. Use Internet Explorer on the lab desktop to access the vSwitchController configuration site at
https://10.10.<A1>.15, replacing <A1> with the pool master host's ID in Administrator 1's
student reference guide. Use the admin/admin credentials to login and then update the
password to Password1.
a. Open Internet Explorer on the lab desktop and enter https://10.10.<A1>.15.

Replace <A1> with the pool master host's ID in Administrator 1's student reference guide.
b. Click Continue to this website on the security warning.
c. Type admin in the Username field, admin in the Password field and click Login.
d. Type Password1 in the New Password and Confirm Password fields, then click Change

Password.
6. Access the NTP settings on the configuration site and add the environment NTP server IP

address.
a. Click Settings in the Distributed Virtual Switch Controller GUI.
b. Click Time & NTP.
c. Click Add NTP Server.
d. Type the written down NTP IP address into the NTP Server Address field and click Add.
The new NTP server is listed with a green icon.

AdministratorAdministrator 11: Adding the Resource Pool to the
Distributed Virtual Switch Controller
1. Add the pool master host using the admin/Password1 credentials.

a. Click Visibility & Control in the Distributed Virtual Switch Controller GUI.
b. Click Add Resource Pool.
c. Type 10.10.<A1>.10 in the Pool Master Server field.

Replace <A1> with the pool master host's ID in Administrator 1's student reference guide.
d. Enter the root/Password1 credentials and click Connect .

The Distributed Virtual Switch Controller scans for all networks, XenServer hosts, and
virtual machines.

2. Allow the distributed virtual switch to connect to the servers in the pool and return a green
status. This may take several minutes.
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Network errors may appear in the distributed virtual switch controller configuration site,
but these can safely be ignored.

AdministratorAdministrator 1:1: Create a Distributed Virtual Switch
Controller Snapshot
1. Access the configuration snapshot settings.

a. Click Settings in the GUI.
b. Click Configuration Snapshots.

2. Create a new snapshot called "Base".
a. Click Create New Snapshot.
b. Type Base in the description field and click Create Snapshot.

The new snapshot is created and listed under Configuration Snapshots.
3. View the information available on the dashboard and then close Internet Explorer.

a. Click Dashboard and view the information available.
b. Close Internet Explorer.

4. Please communicate to your partner when this task is completed.
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Exercise 9-2: Creating and Testing a Cross-
Server Private Network

Scenario

You recently imported the Distributed Virtual Switch Controller. You now need to create the cross-
server private network and test it by verifying the connections between two virtual machines across
XenServer hosts on the cross-server private network.

Before You Begin

To begin this lab, ensure that the following virtual machines are started:

• DomainController
• LicenseServerVPX
• ProvisioningServicesHost-1
• ProvisioningServicesHost-2
• Router
• QA-System (1) - QA-System (6)
• vSwitchController

Estimated time to complete this exercise: 20 minutes

AdministratorAdministrator 22: Creating a Cross-Server Private Network
1. Please wait for your partner to indicate that they have completed the previous tasks before

continuing.
2. Begin creating a Cross-Server Private Network on the CCH QualityAssurance Pool pool.

a. Select CCH QualityAssurance Pool and select the Networking tab.
b. Click Add Network.
c. Select Cross-Server Private Network and click Next.

3. Call the network "Temporary Staging Network". Use Network 0 as the management interface
and complete the wizard. Do not have this network automatically added to new virtual
machines.
a. Type Temporary Staging Network in the Name field and click Next.
b. Ensure that Network 0 is selected in the Management interface menu.
c. Ensure that Automatically add this network to new virtual machines is not selected and

click Finish.
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4. Please communicate to your partner when this task is completed.

AdministratorAdministrator 11: Adding a Virtual Machines to the Cross-
Server Private Network
1. Please wait for your partner to indicate that they have completed the previous tasks before

continuing.
2. Create a snapshot of the DomainController virtual machine called "Base Config".

a. Select the DomainController virtual machine, then click the Snapshots tab.
b. Click Take Snapshot.
c. Type Base Config in the Name field.
d. Use the default Snapshot mode and click Take Snapshot.

3. Create a new VM from the Base Config called "TemporaryDC" using no installation media.
a. Right-click the Base Config snapshot icon, and click New VM from Snapshot.
b. Verify that the Base Config snapshot is selected and click Next.
c. Type TemporaryDC in the name field and click Next.
d. Ensure <empty> is selected the DVD Drive menu and click Next.

4. Place the new virtual machine on the pool master using the default processor and memory
resources.
a. Verify that the pool master is selected, and click Next.
b. Use the default values for vCPU and Memory, and click Next.

5. Use the default virtual disks will be created using fast clone on the local storage.
a. Ensure that two new virtual disks will be created on the local storage.
b. Verify that Use storage-level fast disk clone is selected, and click Next.

6. Use the Temporary Staging Network as the only network associated with the virtual machine
and complete the wizard with the new virtual machine starting automatically.
a. Select the current network interface from the list and click Properties.
b. Select Temporary Staging Network from the Network drop-down menu, and click OK.
c. Verify the settings and click Next.
d. Verify Start the new VM automatically is selected, and click Finish.

7. Please communicate to your partner when this task is completed.

AdministratorAdministrator 22: Adding Virtual Machines to the Cross-
Server Private Network
1. Please wait for your partner to indicate that they have completed the previous tasks before

continuing.
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2. Create a new VM from the CentOSLinuxServer-Template called "TemporaryServer" with no
installation media.
a. Right-click CentOSLinuxServer-Template and click New VM wizard.
b. Verify that the CentOSLinuxServer-Template snapshot is selected and click Next.
c. Type TemporaryServer in the name field and click Next.
d. Verify that <empty> from the DVD Drive menu and click Next.

3. Place the VM on the second XenServer using the default processor and memory resources.
a. Select Place the VM on this server.
b. Select the second XenServer host, and click Next.
c. Use the default values for vCPU and Memory, and click Next.

4. Use storage-level fast disk clone to create a virtual disk on the Shared VM Storage.
a. Verify that Shared VM Storage is selected.
b. Verify that Use storage-level fast disk clone is selected, and click Next.

5. Use the Temporary Staging Network as the only network associated with the virtual machine
and complete the wizard with the new virtual machine starting automatically.
a. Select the current network interface from the list and click Properties.
b. Select Temporary Staging Network from the Network dropdown menu.
c. Verify Auto-generate a MAC address is selected, and click OK.
d. Verify the settings and click Next.
e. Verify Start the new VM automatically is selected, and click Finish.

6. Please communicate to your partner when this task is completed.

BothBoth AdministratorsAdministrators: Testing the Cross-Server Private
Network
1. Administrator 1 complete the following steps:

Administrator 2, please continue to your specific task below. These tasks can be performed
concurrently.

2. Please wait for your partner to indicate that they have completed the previous tasks before
continuing.

3. View the console of the TemporaryServer virtual machine and log on with the root/Password1
credentials.
a. ClickTemporaryServer virtual machine and click the Console tab.
b. Log in using root/Password1 credentials.

4. Use the ping command to test communication with the TemporaryDC virtual machine
(192.168.2.100) located on the pool master. Attempt to ping the pool master XenServer host
(10.10.<A1>.10), replacing <A1> with the pool master host's ID in Administrator 1's student
reference guide.
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a. Type ping 192.168.2.100 and press Enter.

The ping has a response from the 192.168.2.100 because the virtual machine is within the
same cross-server private network, even when on another host in the pool.

b. Press CTRL+C to stop the ping operation.
c. Type ping 10.10.<A1>.10 and press Enter.

Replace <A1> with the pool master host's ID in Administrator 1's student reference guide.
d. Press CTRL+C to stop the ping operation.

No response is received from the pool master XenServer host because this virtual machine
is on a private network to which the XenServer host is not a member.

5. Please communicate to your partner when this task is completed.
6. Please wait for your partner to complete their steps in this task before continuing.
7. When your partner has completed their steps in this task, shutdown and delete the

TemporaryServer virtual machine along with all associated virtual disks.
a. Right-click TemporaryServer and click Shut Down.

Wait until the virtual machine completely shuts down.
b. Right-click TemporaryServer and click Delete VM.
c. Verify the attached virtual disks are selected, then click Delete.

8. Administrator 2 complete the following steps:
These tasks can be performed concurrently with Student 1.

9. View the IP address of the TemporaryServer virtual machine.
a. Select the TemporaryServer virtual machine, then click the Networking tab.
b. Write down the IP address listed.

10. View the console of the TemporaryDC virtual machine and log on as the CCH\CitrixAdmin
user.
a. Click TemporaryDC and click the Console tab.
b. Log on as the CCH\CitrixAdmin/Password1 user.

11. Within a command prompt use the ping command to test communication with the
TemporaryServer virtual machine located on the pool master. Attempt to ping the pool master
XenServer host (10.10.<A1>.10), replacing <A1> with the pool master host's ID in
Administrator 1's student reference guide.
a. Click Start > Command Prompt.
b. Type ping <insert IP of TemporaryServer> and press Enter.
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The ping has a response from the TemporaryServer because the virtual machine is within
the same cross-server private network, even when on another host in the pool.

c. Type ping 10.10.<A1>.10 and press Enter.
Replace <A1> with the pool master host's ID in Administrator 1's student reference guide.

d. Verify that the destination host is unreachable.

No response is received from the pool master XenServer host because this virtual machine
is on a private network to which the XenServer host is not a member.

12. Please communicate to your partner when this task is completed.
13. Please wait for your partner to indicate that they have completed the previous tasks before

continuing.
14. When your partner is completed with their tasks, shutdown and delete the TemporaryDC

virtual machine along with all associated virtual disks.
a. Right-click TemporaryDC and click Shut Down.

Wait until the virtual machine completely shuts down.
b. Right-click TemporaryDC and click Delete VM.
c. Verify the attached virtual disks are selected, then click Delete.

15. When your partner is completed with their tasks, shutdown and delete the TemporaryServer
virtual machine along with all associated virtual disks.
a. Right-click TemporaryServer and click Shut Down.

Wait until the virtual machine completely shuts down.
b. Right-click TemporaryServer and click Delete VM.
c. Verify the attached virtual disks are selected, then click Delete.
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Exercise 10-1: Enabling the Workload
Balancing Virtual Appliance

Scenario

To accommodate the greater workloads required by change in the scope of the project, you need to
maximize the efficiency of the resource pool. To accomplish this, you need to configure a workload
balancing virtual appliance and connect it to the pool. With workload balancing enabled, workloads
can shift between XenServer hosts as needed to ensure optimal performance.

Before You Begin

To begin this lab, ensure that you have the following virtual machines turned on:

• DomainController
• LicenseServerVPX
• ProvisioningServicesHost-1
• ProvisioningServicesHost-2
• Router
• QA-System (1) - QA-System (6)
• vSwitchController

Estimated time to complete this exercise: 30 minutes

AdministratorAdministrator 11: Importing the Workload Balancing Virtual
Appliance
1. Use XenCenter to import the Workload Balancing virtual appliance located in

c:\XenServer\XenServer-6.0-wlb.xva into theCCH QualityAssurance Pool.
a. In XenCenter, click File > Import.
b. Browse to c:\XenServer\XenServer-6.0-wlb.xva and click Open.
c. Click Next.
d. Select CCH QualityAssurance Pool as the home server and click Next.

2. Use Shared VM Storage for the virtual appliance's virtual disk and Network0 as the Network.
Complete wizard allowing the virtual machine to start after import.
a. Choose Shared VM Storage and click Import.
b. Confirm Network0 is selected and click Next.
c. Verify that the Start VM(s) after import option is selected and click Finish.
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The Workload Balancing virtual machine appears and starts automatically.
3. Rename the Citrix WLB Virtual Appliance to WorkloadBalancingVPX .

a. Right-click Citrix WLB Virtual Appliance and click Properties.
b. Type WorkloadBalancingVPX in the Name field and click OK.

AdministratorAdministrator 11: Configuring the Workload Balancing Virtual
Appliance
1. View the console of the WorkloadBalancingVPX virtual machine and set the password of the

root user to Password1.
a. Select WorkloadBalancingVPX and click the Console tab.
b. Type Password1 and press Enter.

The console does not display placeholders for the characters.

c. Retype Password1 and press Enter.
2. Configure the Citrix WLB Virtual Appliance with a hostname of WBVPX and a domain suffix

cch.local. Do not use DHCP to configure network settings.
a. Type WBVPX as the hostname and press Enter.
b. Type cch.local as the domain suffix and press Enter.
c. Type n and press Enter to configure the network settings manually.

3. Set the IP address to 10.10.<A1>.40 with a subnet mask of 255.255.255.0 and gateway
10.10.<A1>.1, replacing <A1> with the pool master host's ID in Administrator 1's student
reference guide. Allow the virtual appliance to restart.
a. Type 10.10.<A1>.40 and press Enter.

Replace <A1> with the pool master host's ID in Administrator 1's student reference guide.
b. Type 255.255.255.0 for the netmask and press Enter.
c. Type 10.10.<A1>.1 and press Enter.

Replace <A1> with the pool master host's ID in Administrator 1's student reference guide.
d. Verify that the network settings are correct and type y and press Enter.

The WLB_Appliance restarts and is configured with the new network settings.
4. Create Workload Balancing database account using the default user name "postgres" and

"Password1" as the password.
a. Press Enter to use the postgres as the default user name.
b. Type Password1 and press Enter.
c. Retype Password1 and pressEnter.

108 Module 10: Workload Balancing © Copyright 2012 Citrix Systems, Inc.



5. Create the Workload Balancing server credentials with wlbuser as the user name, the default
port, and Password1 as password.
a. Press Enter to use the wlbuser as the default user name.
b. Type Password1 and press Enter.
c. Retype Password1 and press Enter.
d. Press Enter to use the 8012 as the default port.

6. Please communicate to your partner when this task is completed.

AdministratorAdministrator 22: Connecting a Resource Pool to the
Workload Balancing Virtual Appliance
1. You can follow along with your partner's progress by viewing the console of the

WorkloadBalancingVPX virtual machine, when available.
2. Please wait for your partner to indicate that they have completed the previous tasks before

continuing.
3. Access the resource pool's workload balancing settings and begin connecting it to the workload

balancing server.
a. Select CCH QualityAssurance Pool and click the WLB tab.
b. Click Connect.

4. Connect the resource pool to the workload balancing server at 10.10.<A1>.40 using the
wlbuser/Password1 credentials, replacing <A1> with the pool master host's ID in Administrator
1's student reference guide. Use the current XenServer credentials.
a. Type 10.10.<A1>.40 in the Address field.

Replace <A1> with the pool master host's ID in Administrator 1's student reference guide.
b. Type wlbuser/Password1 in the WLB Server Credentials section.
c. Select Use the current XenServer credentials and click OK.
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Exercise 10-2: Accepting Workload
Balancing Optimization Recommendations

Scenario

You recently imported the Workload Balancing Virtual Appliance and configured the pool to use it.
Now you need to configure the workload balancing settings to ensure the most efficient balancing
to achieve maximum performance.

Before You Begin

To begin this lab, ensure that you have the following virtual machines started:

• DomainController
• LicenseServerVPX
• ProvisioningServicesHost-1
• ProvisioningServicesHost-2
• Router
• QA-System (1) - QA-System (6)
• vSwitchController
• WorkloadBalancingVPX

Estimated time to complete this exercise: 30 minutes

AdministratorAdministrator 22: Adjusting Workload Balancing Settings
1. Access the resource pool's Workload Balancing settings and set it to automatically apply the

optimization recommendations.
a. Click Settings in Resource Pool WLB tab.
b. Click Automation and select Automatically apply Optimization recommendations.

2. Adjust critical threshold settings of the CPU Utilization to 40% and Free Memory to 2048MB.
a. Select Critical Thresholds.
b. Type 40 in the CPU Utilization field.
c. Type 2048 into the Free Memory field and click OK.

3. Please communicate to your partner when this task is completed.
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AdministratorAdministrator 11: Continuing to Configure Workload
Balancing
1. Please wait for your partner to indicate that they have completed the previous tasks before

continuing.
2. Access the resource pool's workload balancing settings.

a. Click CCH QualityAssurance Pool and click the WLB tab.
b. Click Settings.

3. Set the Metric Weighting of the Network Read, Network Write, Disk Write and Disk Read to
be less important.
a. Select Metric Weighting.
b. Slide the slider of the Network Read, Network Write, Disk Read, and Disk Write to Less

Important.
4. Access the Advanced settings and set the VM Migration Interval to 5 minutes. Set the

Recommended Severity to Low and the Optimization Aggressiveness to High.
a. Select Advanced.
b. Type 5 in the VM Migration Interval field
c. Select Low in the Recommendation Severity menu.
d. Select High in the Optimization Aggressiveness menu, and click Ok.

5. Use the QA-System template to quick create another 6 virtual machines.
a. Right-click the QA-System template and select Quick Create.
b. Perform sub-step a five more times.

Even though the QA-System is set to start all of the virtual machines on the pool master,
the workload balancing system is automatically switching the new virtual machines to run
on the second XenServer.

6. Please communicate to your partner when this task is completed.
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Exercise 10-3: Generating Workload
Balancing Reports

Scenario

You recently configured the workload balancing preferences. Now you want to run a few reports to
see what kind of valuable information they contain.

Before You Begin

To begin this lab, ensure that you have:

• DomainController
• LicenseServerVPX
• ProvisioningServicesHost-1
• ProvisioningServicesHost-2
• Router
• QA-System (1) - QA-System (12)
• vSwitchController
• WorkloadBalancingVPX

Estimated time to complete this exercise: 10 minutes

BothBoth AdministratorsAdministrators: Generating Workload Balancing
Reports
Use the following procedure to generate a Workload Balancing report.

1. Administrator 1 complete the following steps:
Administrator 2, please continue to your specific task below. These tasks can be performed
concurrently.

2. Create a Pool Audit Trail Workload Balancing Report for activity since Monday.
a. Click CCH QualityAssurance Pool and click the WLB tab.
b. Click Reports.
c. Enter last Monday's date in the Start Date field and today's date into the End Date field.
d. Select Pool Audit Trail and click Run Report.

3. Review the information contained generated in the report and save it as a PDF on the local
desktop called "PoolAuditTrail".
a. View the report to see the information it contains.
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b. Click the Diskette icon and select Acrobat (PDF) file.
c. Type PoolAuditTrail and click Save.
d. Click Close.

4. Administrator 2 complete the following steps:
These tasks can be performed concurrently with Student 1.

5. Create a Virtual Machine Motion History Report for activity since Monday.
a. Click Reports.
b. Enter last Monday's date in the Start Date field and today's date into the End Date field.
c. Select Virtual Machine Motion History and click Run Report.

6. View the report and the information contained generated in it and save it as a PDF on the
local desktop called "VMMotionHistory".
a. View the report to see the information it contains.
b. Click the Diskette icon and select Acrobat (PDF) file.
c. Type VMMotionHistory and click Save.
d. Click Close.
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Exercise 11-1: Creating a vApp

Scenario

Some sets of virtual machines that work together exclusively. It would be best to manage them as a
single entity rather than as separate virtual machines using the vApp feature. You identify two
separate infrastructures that you want to make into vApps: Provisoning Services Infrastructure, and
XenServer Infrastructure.

To save time you want to divide up the tasks between you and the other administrator.
Administrator 2 will create the Provisioning Services vApp and Administrator 1 will create the
XenServer Infrastructure vApp.

Before You Begin

To begin this lab, ensure that you have the following:

• DomainController
• LicenseServerVPX
• ProvisioningServicesHost-1
• ProvisioningServicesHost-2
• Router
• QA-System (1) - QA-System (12)
• vSwitchController
• WorkloadBalancingVPX

Estimated time to complete this exercise: 15 minutes

AdministratorAdministrator 22: Creating a vApp for Provisioning Services
Infrastructure
This task can be performed concurrently with the similar lab performed by Administrator 1.

1. Begin configuring a new vApp in XenCenter.
a. Right-click CCH QualityAssurance Pool > Manage vApps .
b. Click New vApp.

2. Create a new vApp called "Provisioning Services vApp" containing the DomainController ,
ProvisioningServicesHost-1 , and ProvisioningServicesHost-2 virtual machines.
a. Type Provisioning Services vApp in the Name field and click Next.
b. Select the DomainController, ProvisioningServicesHost-1, and

ProvisioningServicesHost-2 check boxes and click Next.
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3. Change the virtual machine start order so that the DomainController starts first with an order
of 0, and then both the ProvisioningServicesHost-1 and ProvisioningServicesHost-2 virtual
machines started second with an order of 1 with a 120 second delay.
a. Select ProvisioningServicesHost-1 from the VM Startup Sequence list.
b. Type 1 in the Start order field.
c. Type 120 in the Attempt to start next VM after field.
d. Perform substeps b and c with the ProvisioningServicesHost-2 virtual machine and click

Next.
4. Complete new vApp wizard confirming that it is properly defined with the 3 virtual machines.

a. Click Finish to create the vApp.
b. Verify the vApp name, and the selected virtual machines are included and click Close.

5. Please communicate to your partner when this task is completed.

AdministratorAdministrator 11: Creating a vApp for XenServer
Infrastructure Virtual Machines
This task can be performed concurrently with the similar lab performed by Administrator 2.

1. Begin configuring a new vApp in XenCenter.
a. Right-click CCH QualityAssurance Pool > Manage vApps .
b. Click New vApp.

2. Create a new vApp called "XenServer Infrastructure vApp" containing the Router ,
LicenseServerVPX, vSwitchController ,and WorkloadBalancingVPX virtual machines.
a. Type XenServer Infrastructure vApp in the Name field and click Next.
b. Select the Router, LicenseServerVPX, vSwitchController, and WorkloadBalancingVPX

check boxes and click Next.
3. Change the virtual machine start order so that the Router starts first with an order of 0, and

then the LicenseServerVPX, vSwitchController , and WorkloadBalancingVPX virtual machines
started second with an order of 1 with a 60 second delay.
a. Select LicenseServerVPX from the VM Startup Sequence list.
b. Type 1 in the Start order field.
c. Type 60 in the Attempt to start next VM after field.
d. Perform steps b & c on the vSwitchController and WorkloadBalancingVPX virtual

machines.
e. Click Next.

4. Complete new vApp wizard confirming that it is properly defined with the 4 virtual machines.
a. Click Finish to create the vApp.
b. Verify the vApp name, and the selected virtual machines are included.
c. Click Close.
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AdministratorAdministrator 11: Verifying the Virtual Appliance
1. Please wait for your partner to indicate that they have completed the previous tasks before

continuing.
2. Shut down all 12 QA-System virtual machines and ensure they are all off before continuing.
3. Shutdown the "Provisioning Services vApp" components

a. Right-click CCH QualityAssurance Pool and click Manage vApps.
b. Click Provisioning Services vApp and click Shut down
c. Click Yes to confirm the shut down operation.

Wait for the virtual machines to completely shut down.

Note that the virtual machines automatically shut down in the reverse order of how they
were set to start up.

4. After all the Provisioning Services vApps shutdown successfully shut down the "XenServer
Infrastructure vApp".
a. Click XenServer Infrastructure vApp and click Shut down
b. Click Yes to confirm the shut down operation.

Wait for the virtual machines to completely shut down.
c. Click Close.

5. Please communicate to your partner when this task is completed.

AdministratorAdministrator 2:2: Using the vApps
1. Please wait for your partner to indicate that they have completed the previous tasks before

continuing.
2. Access the vApps and start the "XenServer Instrastructure vApp". Wait 2 minutes until all

virtual machines are fully started before continuing.
a. Right-click CCH QualityAssurance Pool and click Manage vApps.
b. Click XenServer Infrastructure vApp and click Start

Wait for the virtual machines to fully start. This may take several minutes.
3. Access the vApps and start the "Provisioning Services vApp". Wait 2 minutes until all virtual

machines are fully started before continuing.
a. Click Provisioning Services vApp and click Start

Wait for the virtual machines to fully start. This may take several minutes.
b. Click Close.

4. Start the QA-System (1) through QA-System (6) virtual machines.
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a. Shift-click the QA-System (1) virtual machine and shift-click the QA-System (6) virtual
machine.

b. Click Start.
c. Click QA-System (1) and click Console.
d. Verify that the virtual machine is starting into Windows.

If the virtual machine is not booting to windows, ensure that the Provisioning Services
Hosts have completed their startup and/or restart them.

5. Please communicate to your partner when this task is completed.
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Exercise 11-2: Configuring High Availability

Scenario

The Quality Assurance team needs to have the Provisioning Services Infrastructure available at all
times. They need to be up even in the case where a XenServer host goes down. To comply with this
request you need to configure high availability on the Provisioning Services Infrastructure. You
then want to test HA by causing an abrupt non-graceful system restart of a XenServer host.

Before You Begin

To begin this lab, ensure that you have the following:

• DomainController
• LicenseServerVPX
• ProvisioningServicesHost-1
• ProvisioningServicesHost-2
• Router
• QA-System (1) - QA-System (6)
• vSwitchController
• WorkloadBalancingVPX

Estimated time to complete this exercise: 20 minutes

AdministratorAdministrator 11: Enabling High Availability
1. Begin configuring High Availability on the resource pool using the Shared VM Storage

repository.
a. Click CCH QualityAssurance Pool and click the HA tab.
b. Click Configure HA and click Next.
c. Select Shared VM Storage and click Next.

2. Configure the ProvisioningServicesHost-1 , ProvisioningServicesHost-2 , and
WorkloadBalancingVPX virtual machines to each restart at order 0 and with no delay.
a. Click the Virtual Machine column header to sort the list by virtual machine name.
b. Click ProvisioningServicesHost-1 and select Restart in the HA restart priority menu.
c. Type 0 in the Restart Order and Attempt to start next VM after fields.
d. Repeat substeps b - c with the ProvisioningServicesHost-2 and WorkloadBalancingVPX

virtual machines.
3. Configure the non-agile virtual machines to not restart and complete the configure HA wizard.
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a. Click the Agile column header to sort the list by agile status.
b. Click any non-agile virtual machines with a restart priority of Restart.
c. Select Do not restart in the HA restart priority dropdown menu.
d. Repeat substeps b - e with the other virtual machines that are not listed as agile.
e. Click Next.

If the Next button is not available to you, ensure that any virtual machine not listed as
agile has the restart policy "Do not restart".

f. Review the configuration summary, and click Finish.
4. Please wait for the Enabling HA process to completed before communicating to your partner.
5. Please communicate to your partner when this task is completed.

AdministratorAdministrator 22: Verifying Automatic Host Migration to Pool
Master
1. Please wait for your partner to indicate that they have completed the previous tasks before

continuing.
2. Ensure that the QA-System (1) through QA-System (6), WorkloadBalancingVPX , virtual

machines are on the secondary XenServer host before continuing.

If they are not on that host, please use XenMotion to move them to the second host
before continuing.

3. Ensure that the following virtual machines are running on the secondary XenServer host:
• QA-System (1) through QA-System (6)
• WorkloadBalancingVPX
• ProvisioningServicesHost-1
• ProvisioningServicesHost-2

If any of these virtual machines are not running on the secondary XenServer host, use
XenMotion to migrate them to the secondary XenServer host.

4. Launch the putty.exe utility located at C:\XenServer\putty.exe on the lab desktop.
a. Navigate to C:\XenServer, on the lab desktop.
b. Double-click putty.exe.

5. Use 10.10.<A2>.10 IP address in the host name field, replacing <A2> with the secondary host's
ID in Administrator 2's student reference guide. Open a new session using the SSH protocol
and log on with the root/Password1 credentials.
a. In the Host Name field, type 10.10.<A2>.10.
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Replace <A2> with the secondary host's ID in Administrator 2's student reference guide.
b. Verify that the SSH protocol is selected, and click Open.

Please double check that you are connecting to the secondary host and not the pool
master.

c. Click Yes in the security alert.
d. Log on to the pool master using the root/Password1 credentials.

6. Enter the following commands to cause an instant non-graceful reboot of the XenServer host:

echo 1 > /proc/sys/kernel/sysrq

echo b > /proc/sysrq-trigger

You will not receive a prompt back once the second command is entered.

7. View the resource pool's HA status, and wait until the heartbeat returns an error and High
Availability policies begin.
a. Click CCH QualityAssurance Pool and click HA.
b. Watch the heartbeat status change after a few minutes, and the high availability virtual

machines are restarted on the pool master.
8. Wait until the second XenServer Host boots and reconnects to the pool before continuing.
9. Start the QA-System (1) through QA-System (6) virtual machines.

a. Select QA-System (1).
b. Shift-click QA-System (6) and click Start.
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Exercise 12-1: Using the xe Command-Line
Interface

Scenario

Your manager wants you and your partner to become more experienced with the command line
interface to better troubleshoot any potential issues.

Before You Begin

Before you begin this lab, ensure that you have the following virtual machines on:

• DomainController
• LicenseServerVPX
• ProvisioningServicesHost-1
• ProvisioningServicesHost-2
• Router
• QA-System (1) - QA-System (6)
• vSwitchController
• WorkloadBalancingVPX

Estimated time to complete this exercise: 45 minutes

BothBoth AdministratorsAdministrators: Logging on to the Server Console
using SSH
1. Close Citrix XenCenter.
2. Launch the putty.exe application located in the C:\XenServer folder.

a. On the local desktop, navigate to C:\XenServer.
b. Double-click putty.exe.

3. Enter your host server IP address in the host name field, using the SSH protocol, and open a
new session. Log on to the XenServer host as the root/Password1 user.
a. Type 10.10.<x>.10 in the Host Name field.

Where <x> is your host server ID.
b. Verify that the SSH protocol is selected, and click Open.
c. Click Yes in the putty security alert.
d. Log on as the root/Password1 user.
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BothBoth AdministratorsAdministrators: Removing a Virtual Machine using the
Command Line Interface
1. Use the xentop command and write down how many virtual machines are running on your

host.
a. Type xentop and press Enter.
b. Resize the putty.exe window to display all the information.
c. Type q to exit xentop and return to the command prompt.

2. Use a command to view the hosts in the resource pool and write down the first four characters
of the UUID of your host.
a. Type xe host-list and press Enter.
b. Write down the first four characters of the UUID of your host.

3. Use a command to view all the running virtual machines running only on your host. Write
down the UUID of one of the QA-System virtual machines.
a. Type xe vm-list power-state=running resident-on=<hostUUID> press

Tab to autocomplete the host UUID.

Where hostUUID is the first four characters of your host server UUID, written down
previously.

b. Press Enter to view the results.
c. Write down the first four characters of a QA-System virtual machine UUID.

If a QA-System virtual machine is not available on your host, use XenCenter to migrate
one to it.

4. Use a command to view the parameters associated with this virtual machine.
a. Type xe vm-param-list uuid=QA-SystemUUID press Tab to autocomplete the

QA-System UUID.

Where QA-SystemUUID is the first four characters of the QA-System UUID written
down previously.

b. Press Enter to view the results.
5. Use a command to shut down the QA-System virtual machine captured previously.

a. Type xe vm-shutdown uuid=QA-SystemUUID in the console and press Tab.

Where QA-SystemUUID is the first four characters of the QA-System UUID, written
down previously.

b. Press Enter to shut down the virtual machine.
6. Use a command to view all the running virtual machines running only on your host. Verify

that the QA-System virtual machine from the previous step is not in the list.
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a. Type xe vm-list power-state=running resident-on=hostUUID press Tab to
autocomplete the host UUID.

Where hostUUID is the first four characters of the host server UUID.
b. Press Enter to view the results.

7. Use the command to delete the QA-System virtual machine.
a. Type xe vm-destroy uuid=QA-SystemUUID in the console and press Tab.

Where QA-SystemUUID is the first four characters of the QA-System UUID.

There is no confirmation when using the "xe vm-destroy" command. Verify the UUID
before the next step.

b. Press Enter to delete the virtual machine.
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Exercise 12-2: Self-Servicing XenServer

Scenario

While working on the XenServer pool you noticed a few issues that, while not affecting the
workload, you wanted to check out with Citrix Support just to be sure.

Citrix Support asked you to use XenCenter to create a status report to send in to them.

Estimated time to complete this exercise: 10 minutes

BothBoth AdministratorsAdministrators: Viewing a System Status Report in
XenCenter and XenServer
1. Using XenCenter, launch the Server Status Report wizard.

a. Click Start > Citrix XenCenter on the local desktop.
b. Click Tools > Server Status Report from the Toolbar.

The Server Status Report wizard opens.
2. Create a server status report of your XenServer host which includes all the default items and

crash dump files.
a. Select your XenServer host and click Next.
b. Select Crash dump files and click Next.

XenServer compiles the report. This may take a few minutes to complete.
c. Click Next when the file is completed.

3. Save the server status report on the XenCenter desktop. Do not remove the crash dump files.
a. Click Browse and browse to the desktop.
b. Use the existing File name, click Desktop and click Save.
c. Click Finish.

The file is saved to the landing desktop.
d. Click No on the Remove Crash Dump Files message.

4. Open the status-report zip on the XenCenter desktop file to view the server status report.
a. Double-click status-report.zip on the XenCenter desktop to open the zip file.
b. Open the XenCenter.log file and view the content.

5. Close all open windows, except for XenCenter.
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Exercise 12-3: Working with Citrix Support

Scenario

Citrix Support reviewed the status report and did not find any issues. They want you to run a few
other tests to see if they can identify anything wrong.

Estimated time to complete this exercise: 30

BothBoth AdministratorsAdministrators: Performing Network Traces
1. View the console of your XenServer host and access a command prompt.

a. Click your XenServer host and click Console.
2. Execute and stop a network trace on the eth0 physical network interface using the "tcpdump"

command.
a. Type tcpdump -i eth0 -w eth0_trace.
b. Allow the trace to run for 30 sec.
c. Press Ctrl-C to stop the trace.

3. Execute and stop a network trace on the xenbr0 virtual bridge using the " tcpdump" command.
a. Type tcpdump -i xenbr0 -w xenbr0_trace and press Enter.
b. Allow the trace to run for 30 sec.
c. Press Ctrl-C to stop the trace.

4. Use an xe command to get the dom-id and networks of one of the QA-System virtual
machines.
a. Type xe vm-list name-label=QA-System\ \(n\) params=dom-

id,networks
Where n is the number of a QA-System virtual machine running on your host.

b. Write down the dom-id and the virtual interface (vif) number.

The virtual interface (vif) number is the number preceding the slash on the networks line.

5. Execute and stop a network trace on a QA-System virtual machine used in the previous step
running on your host, using the command "tcpdump" command. Then list the trace files listed
in the current directory.
a. Type tcpdump -i vif<DOM-ID>.<V> -w vif_trace.

Replace <DOM-ID> with the dom-id identified in the previous step. Replace <V> with the
virtual interface identified in the last step.

b. Allow the trace to run for 30 seconds.
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c. Press Ctrl-C to stop the trace.
d. Type ls -l and press Enter to view all of the trace files that were captured.

BothBoth AdministratorsAdministrators: Running the Bugtool from the
Command-Line Interface
1. Generate a diagnostic file using the "xen-bugtool" command.

a. Type the command xen-bugtool --yestoall and press Enter.

If both dashes are not placed before yestoall, you will be prompted for each report
individually.

2. Record the filename created at the end of this process.

The filename is of the form bug-report-datestamp.tar.bz2 where datestamp indicates
the date the diagnostic file was created.

Another administrator is going to capture all of these output files and send them in to Citrix
Support for them to be analyzed.
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